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Impact Suite on­line help

Use the panels below to find add‐on solutions for your act! software. Use the search feature above to
find articles matching specific criteria, or browse the categories below. 

New feature in Impact 5.1 

  If you are still unable to find an acceptable solution you can purchase a support agreement
below.

  
Yearly Maintenance Agreement     learn more Yearly Maintenance Agreement $99

Yearly Support Agreement     learn more Yearly Support Agreement $199

Quick Start Program     learn more Quick Start Program $299
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Whats new in 5.1

This page details what is new with each service patch for Impact Suite.

Service Patch 1 build Impact Suite ﴾ build 5.1.0.25﴿  and above

Support for Act! 16.1

Added support for the new add­on manager
Added the new e­Marketing shortcut
Added the new Marketplace shortcut.

 

Project Tracking
Automatically adds the required tables when turning on "Project Tracking" Read more
Totals custom fields such as 'travel time' or ' billable hours'
Ability to display projects on the timeline view. Read more
Option to hide the projects on the standard schedule form while still displaying on the timeline. Read more
Group by any character field in the project table such as record manager or category.  Read more
Select a customized data entry form for the project record. Read more
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New indicators when the project range exceeds the visual timeline. Read more 

Math Functions
Added the ability to run formulas when opening and closing the form Read more
Added the ability to run formulas when changing act! records
Added the ability to run from the Windows Scheduler
Enhanced performance when using multiple math formulas.
Added option to calculate activity totals when the activity list is added to a custom table.

Designer enhancement
New! ­ Cascading drop downs control. Read More
New! ­ Panel control with sub totals.  Read more
Groupbox clear buttons.  Read more
Added a button to lookup contact, companies, groups and opportunities. Read more
Added 'Spell as you type' checking to the memo control Read more
Group boxes and panels controls option to show a button to clear the controls on it 
Look up controls for contact, company, group and opportunity on the custom tables.
Customizable Toolbar on child custom tables 
Re­organized the toolbox buttons on the top toolbar
New child table options when adding new records:  Attach Current Contact, Attact Parent Contacts,
Attach No Contact, Pick from Contacts Attached, Pick from All Contacts

List Views
Added the ability to open multiple records at the same time.
Added the option to highlight columns from the parent tables
Added the ability to customize column captions without altering the field names in the database
Task List only ‐ Added ability to reschedule tasks with keyboard shortcuts 
Added a 'virtual mode' switch for faster refresh with very large lists.
The A‐Z navigation is now part of the "Touch Scroll ﴾Windows 8﴿" preferences
Added a right‐click menu option to assign the record managers and other values
Added a "Lookup All" button to the find panel.
Added the ability to only display active uses ﴾ hides inactive users﴿
Added the ability to display the unique record ID such as; ContactID, CompanyID, GroupID and OpportunityID

Act! Data entry  
New memo control for contact, company, group and opportunity detail views Read more
Memo control with spell checking Read more
Redesigned act! entity picker now remembers last filter and current look up criteria

Document Engine
Added the ability to run a report from the 'Create Document' form. 
Document engine now supports templates created with the Impact Report Designer (*.repx)

Opportunities
Auto add contacts when creating a custom table record from opportunities
Add picture fields to the invoice templates
Added the 'Process' on the custom filters panels at the bottom of the list view

Import improvements
Import_date stamped automatically
Connect to all found setting

Report
Redesigned "Run Report" window. 
Added option to Run Report inside act! or external process. 
Note ­ External processes are sometimes required due to network privilege setting.
Three run­time criteria modes; editable, default and append.
New 'Expression Editor' on the query builder expression column.
New 'Sub Query' builder/editor
Outlook support in the auto run feature
Run reports from act! views. Added an option to display the report in each act! view such as contact,
companies and opportunities. (See Document Engine above)
Option to show/hide the details band
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New feature to import Crystal Reports
Enhanced "Run Report' options allowing designers to limit the criteria options at run time.

Start up query
Added the ability to filter the contact list at start up based a query named "Startup.QRY" Read more 

Syncing
Syncing between master and remote databases is now automatic

Custom Tables
New! Duplicate a custom table; structure or structure and data.
Support for multi­Monitors when editing custom table records
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FAQs
Frequently Asked Questions

Can I test drive your add­ons?
Yes, all of our add‐ons have a 30 day free test drive. You can download any modules or the Impact Suite on the page below:

http://www.durkincomputing.com/Download.aspx

How do I purchase?

Individual modules can be purchased by clicking the link below. After entering your credit card information, 
you will receive an activation key by email which can be entered into the evaluation version to register it.

http://www.durkincomputing.com/Purchase.aspx

Credit cards accepted: Visa,  MasterCard,  American Express and PayPal.

How to get support?

Durkin Computing offers free technical support to our customers and companies evaluating our products.

Technical Support:

Our technical support team is committed to providing superior support service, and is available Monday to Friday, 9AM‐5PM Eastern Standard Time. We typically
answer inquiries within a few hours, and within two business days at most. 

Email: Support@DurkinComputing.com 

Does Durkin Computing do any consulting services?
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Consulting Services:  

Durkin Computing is an authorized SAGE Add‐on Partner. If you are looking for custom software, then contact us!

Contact Information:
Email: Sales@DurkinComputing.com 
Phone: 1 + ﴾973﴿ 625‐1119

Is there a community forum?

Community Forum:

Whilst we cannot guarantee instant technical support via the community forum we will always try to assist quickly. For guaranteed assistance from our staff
please use the Ticket System. 

Goto Community Forums »

Is there a PDF manual I can read?

A PDF Manual is self‐contained printable document which can be downloaded and distributed. The "PDF" format has become a widely accepted internet standard for printing
and distributing product documentation. 

Click here for more information about the PDF standard. 
If your computer does not have the PDF viewer installed, it can be downloaded from Adobe's website. 

Durkin Computing provides both an online help system and a downloadable PDF manual on their website.

Advantages:

Very portable. Easily downloaded, emailed, etc.
Easy to print.
Retains formatting, regardless of fonts installed.
Widely accepted Internet standard.

Our PDF Manuals have the same content as the on‐line help system, and they look and feel very different. See the example below:

Can it run on a Terminal Server or Citrix Server
Yes, please read this section for more info. Citrix or Terminal Server
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Ask Questions

Get help from Customer Support or other resources

Ask Someone

Post a question or search for an answer in our online community forum .

Customer Support

Contact our customer support department by email at support@DurkinComputing.com

 

 

If you're unable to find what you're
looking for in this help system, try
these alternative resources:

Community Forum

Knowledgebase

FAQ

Contact our support department:
support@DurkinComputing.com 

Phone: [PhoneSupportNumber]
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How to Order

Home > Welcome > How to Order

How to Order
The Impact Suite, individual add‐ons or The Impact Report Designer can be purchased from our web site using the link
below. Immediately after the transaction is processed you will receive an activation key by email which can be entered into the
evaluation version to register it.

Step 1
Add items into your shopping cart from this page: http://durkincomputing.com/Purchase.aspx

Step 2
Verify your shopping cart and click green CONTINUE
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Step 3
Enter your billing information and click on the green CONTINUE button

Step 4
Enter your payment information, answer additional information and click the green PLACE YOUR ORDER button

Next Article



Once the transaction is complete you will receive tow email:
1﴿ An email receipt for your accounting records.
2﴿ An email with your new serial numbers.

Credit cards accepted:

Visa
MasterCard
American Express
PayPal

To download an evaluation version use this link:
http://durkincomputing.com/Download.aspx
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How to Get Support
[DurkinComputing] offers free technical support to our customers and companies evaluating our products.

Technical Support:

Our technical support team is committed to providing superior support service, and is available
Monday to Friday, 9AM‐5PM Eastern Standard Time. We typically answer inquiries within a few
hours, and within two business days at most. 

Contact Information:
Email: Support@DurkinComputing.com 
Phone: [PhoneSupportNumber]

Community Forum:

Whilst we cannot guarantee instant technical support via the community forum we will always try
to assist quickly. For guaranteed assistance from our staff please use the Ticket System. 

Goto Community Forums »

Consulting Services:

[DurkinComputing] is an authorized SAGE Add‐on Partner. If you are looking for custom software,
then contact us!

Contact Information:
Email: Sales@DurkinComputing.com 
Phone: [PhoneSupportNumber]
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What is a PDF Manual
A PDF Manual is self‐contained printable document which can be downloaded and distributed. The "PDF"
format has become a widely accepted internet standard for printing and distributing product documentation. 

Click here for more information about the PDF standard. 
If your computer does not have the PDF viewer installed, it can be downloaded from Adobe's website. 

[DurkinComputing] provides both an online help system and a downloadable PDF manual on their website.

Advantages:

Very portable. Easily downloaded, emailed, etc.
Easy to print.
Retains formatting, regardless of fonts installed.
Widely accepted Internet standard.

Our PDF Manuals have the same content as the on‐line help system, and they look and feel very different. See
the example below:
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Impact Suite

Impact Suite is a collection of 10 add‐ons for ACT! also known as modules or plug‐ins. Each has a unique
purpose and can be purchased separately. Together they are a powerhouse of features extending the versatility
of ACT!

To turn ON/OFF individual modules:

1. Install Impact Suite then launch ACT
2. Go to the TOOLS menu and select IMPACT SUITE
3. Change the drop down under Action to ON ‐ enhances this view.
4. Clicking the grey plus signs will enhance that view under the tab

To turn ON/OFF modules or place other users in a 'Runtime' state please see Network Administration 

Individual Add‐ons

Calendar View Plus
Company List Plus
Contact List Plus
Group List Plus
History List Plus
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Getting Started
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Import Wizard

To import a custom table template into the ACT! database follow the below steps.

1. Click Tools

2. Click Define Custom Tables

3. Click Template Wizard under the wizards section on the window

4. Choose a table to install and click the next button

5. The tables to be installed will be shown

6. Click Install Now
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Table Templates

We know of other vendors who try a "one size fit all" approach, our way or the highway types. It doesn't work. 

Many users install a template and start working today. While others heavily customize it so suite their business needs. Either way one
of our templates is going to save you valuable time to get up and running quickly. 

Click on one of the templates on the right to read more information on which one will work for you or contact us about additional
templates.

Review templates
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Home > Impact Suite > Getting Started > Add a Custom Table

Add a Custom Table

Adding custom tables allows you to track information that would have been well‐nigh impossible with native ACT!. Custom tables
can include invoices, events, household items or inventory etc. 

There are two ways to create a custom table: 

Use a table template that includes multiple fields.
Design your table from scratch, by adding your own field list.

For more information please see: Your First Custom Table 

To add a custom table follow these steps:

1. In ACT! go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Click on the CREATE TABLE button
3. Enter the name of the custom table.
4. Select tables to attach to.
5. Click on the SAVE button
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Duplicate a Custom Table

Many times you need to duplicate an existing custom table from one you have already designed. You may need an additional
"Policy" table with the exact same fields. Rather then building this second table from scratch and manually adding each field you can
duplicate an existing table with just a few clicks. Requires Impact Suite 5.1.05 or better.

The duplicate function has an options to copy all data from the original table into the new duplicated table. This is a great feature
 hen you need to rename a table. You can duplicate the original table ﴾with a new name﴿ then delete the original source table.
Duplicating a table may be required if your original table was created with a third party add‐on which allowed space in
the custom table name. Since Impact Suite uses the act! OLEDB2 SQL reader extensively we do not support spaces in table names.
Renaming a table without spaces will be required when using Impact Suite..

Please follow these steps to duplicate a custom table.

1. Open act and go to the TOOLS‐> DEFINE CUSTOM TABLES menu
2. Click the Duplicate Table link on the lower left side.
3. From the drop down select the source table
4. Enter your new table in the text box 
5. Remove the check mark from "Copy All Data" if you only need to fields
6. Click [Create]

You will see a progress bar as the new table and fields are created in your database.

If you have the the option "Copy All Data" checked you will see a second progress bar as each record is duplicated. If your source
table has many records this progress bar may take a few minutes or longer to competed.

Once completed you will receive a dialog box.
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Note ‐ The system fields such as Created Date and Edit date will be set to the current date. The 'Record Creator' and 'Last Edited
By' will be stamped with the current user.
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In‐List Filtering

Find Panel

The Find Panel will find all occurrences of a word in the current list view.

1. Type in the box the text to search
2. Click Find or Enter
3. Click clear to the clear the search and start a new one

Query Builder 
The query builder allows you to design a single or a multi condition ﴾advanced﴿ query. A query is a method of
filtering the list. Once you have designed a query, the list will be filtered on those conditions. 

To create a new query:
1﴿ Select the desired field to query
2﴿ Select the comparison e.g. "Contains"
3﴿ Enter a value e.g. "Chevy" then click "ENTER" on your keyboard

The query builder contains some more advanced query options:

1. Select Fields ‐ Use this drop‐down to select the ACT! field to filter on Make.

2. Comparison Selector ‐ Use this drop‐down to select the comparison operator e.g. "Contains" or "Starts
With"

3. Enter Filter Text ‐ Use this drop‐down to enter the filter text e.g. "Chevy"
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4. Show Fields ‐ This option uses values in a second field to be compared to the first. 
Rather than using the value from 3. Enter Filter Text, this 0ption will use the value from a second field. "Does
FieldA contain value from FieldB?"

5. Invert Criteria ‐ Use this option to invert the filter criteria e.g. "Show me all cars that do not contain "Chevy"

6. Add Criteria ‐ Use this option to add additional criteria line﴾s﴿. "Show me all cars where the Make contains
'Chevy' and the Make contains 'Ford'.

7. Remove Criteria ‐ Use this option to remove additional criteria.

Here is a step‐by‐step example:

1. Click on the QUERIES button on the toolbar. 
2. Click on the CLICK HERE TO ADD FILTER CRITERIA button
3. Select Make from the fields drop‐down.
4. Select Contains from the comparison drop‐down.
5. Enter the value of 'Chevy' in the text box then click RETURN

If you would like to add additional conditions:
6. Click on the ADD CRITERIA button
7. Select Price from the fields drop‐down.
8. Select Greater Than from the comparison drop‐down.
9. Enter the value of '50000' in the text box then click RETURN

This query will return all rows where the make is Chevy and the price is greater than $50,000.

Filter Row

Filter row allows you to quickly filter the list at the top of any column. If you do place two values at the top of
two columns the filter row will always use an "And" comparison condition. Filter row is different to the query
builder in the fact that the filter row can not do advanced or multi‐conditional queries.

1﴿ To access the filter row, click on the FILTER button on the toolbar. 
2﴿ You will now see a empty filter row at the top of the list, displayed in yellow. 
3﴿ Enter a filter in any column, e.g. "United States" in the country column. 
4﴿ Click "Enter' on the keyboard. You now have this filter in place. 



To add additional conditions to the current filter, just enter the text in the column header and click "ENTER"
again.

Operator Condition

= Equals

$ Contains

!$ Not Contains

> Greater Than

< Less Than

>= Greater Than Or Equal To

<= Less Than Or Equal To

<> Not Equal

* Begins With

NULL Is Null

!NULL Is Not Null

EMPTY Is Empty

!EMPTY Is Not Empty

﴾A,B﴿ Between Value A and B

!﴾A,B﴿ Not Between Value A and B

A,B,C Multiple conditions

Here are some examples of filter conditions you can try:

To find all contacts whose Country is empty just type "EMPTY" in the filter row and click "ENTER" 

To find all contacts whose Country is not empty just type "!EMPTY" in the filter row and click "ENTER" ﴾ Notice
the explanation mark before the word ﴿ 

To find all contacts whose Country is either Germany or France or the USA just type "Germany, France, United
States" in the filter row and click "ENTER" ﴾ Notice each condition is separated by a comma ﴿ 

To find all contacts that were edited this month just type "﴾8/1/2005‐8/30/2005﴿" in the filter row and click
"ENTER" 

To find all contacts where a yes/no field is checked just select "TRUE" in the filter row and click "ENTER"
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Color Rules

Color rules are designed to colorize records for rows that match a condition. Color rules can be based on text condition like
the one below. In this color rule we are making all rows blue where the word "Triumph" appears in the MAKE column. 

Lets try a simple color rule like: "Make all the files that the Department = Sales highlighted in green" 

1. First open the Color Rules window by selecting the Color Rules menu in Settings.  
2. Click on the Add button at the bottom of the rules window. 
3. Enter the Rule Name at the top of the window. Lets enter Department = Sales 
4. Change the column to Department 
5. Change the Comparison popup to Contains. 
6. Change the Date/Value﴾s﴿/Custom radio selector to Values﴾s﴿ 
7. Enter the value of Salesinto the Value 1 field. 
8. Click on the color button near the bottom of the window  and select the color green from the color picker window. After
you have closed the color picker window the color button will display the selected color. 
9. Click on Save. 

Now all you have to do is to close the rules window and click on the F5 key to refresh in the list. 

Color Rules colorize all tasks in the list. Color rules can apply to multiple tasks like all 'Meeting' or to
singular tasks like 'Details field = "Bring Projector" 

Color rules are designed to colorize rows or columns from your activities that match any number of conditions. Immediately,
we see three keywords: we need to COLORIZE tasks FROM the list that matches a CONDITION. Hence we have the most
basic Color Rule structure:

COLORIZE "ColumnName" FROM the TaskList Where x=ColumnValue" 

The COLORIZE keyword allows us to color one column or all columns such as Task Type, Regarding, Date, or location.  These
columns are all available to you when you select Customize Columns.

COLOR *Columns* FROM the Task List   Where x=ColumnValue"  

Lastly, we want the color conditions. This is the 'Where' part of the select statement above. 

For example, we may want to display the color Red where the type of activities are high priority. To do this, we use the Color
Rules builder to create the condition.  The rule is built for you by selecting just three simple conditions.
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1. The column to apply the rule to 
2. The comparison operator 
3. The value to compare. 
4. The color to highlight

In the example of activities where priority is equal to 'High' would read like this.

1. Column = TaskType 
2. Comparison = Equal  
3. Clause = High 
4. Color = Red 

In a sentence this would read. Display all files with Red where the TaskType column contains a values of "High".

Color rules are applied alphabetically. To change the order add letters to the front of each rule

a. Color Rule yellow
b. Color Rule blue
c. Color rule green
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Network Administration

If you are installing Impact Suite on a Microsoft Terminal Server or a Citrix server and all the users do not need access  to a
specific module or custom table you can use our Administration Panel to select which users have access. To access this panel
please follow these steps:

To open the administrators panel:
1﴿ Log into ACT as the database administrator

2﴿ Go to the TOOLS menu and select IMPACT...

3﴿ On this form click on the "Open Administrator Panel" button

 
Use the drop down next to the user name to change the product mode: Mode options are designer, Runtime or bypassed.

Designer mode:  The user has full access to change any setting or options. If the user is manager or above then the can also alter
or change the custom tables fields and layouts.

Run time Mode: the user has limited access to only the modules specified in the Active column.  Checking the mode column will
allow the user to enhance the list view, checking the multi‐monitor column will allow the user to move the list view to a separate
monitor, swtiching the tab columns to on will allow the use to have the enhanced view on the tab.

Bypassed Mode: Impact has no effect inside the ACT interface. This option is used when only a limited number of users need access
to modules while others need no Impact modules installed. 

Bypassed mode is also useful when installing Impact on a terminal server and only the sales department need access. All other
users on the server can be set to the bypassed mode.
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Home > Impact Suite > Getting Started > Tables List Plus Web

Tables List Plus Web
To install the files needed for the web install Impact Suite or Tables List Plus and run Act to copy over the data entry and column
files.  The data entry and column files are edited in the desktop version of Act.  The web.dly and web.layout are the files to edit for
the web.

To install the Tables List Plus Web download the installer and run the installer on your server where Act for Web is installed.  After
installation the IIS needs to be restarted.

To install the layout and columns you need to open Tables List Plus or Impact Suite on the Act for Web server and edit the web data
entry form and web column layout for the web tables to consume.
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Home > Impact Suite > Settings and Options

Settings and Options

To get to the settings for Impact Business Suite in ACT! go to Tools > Durkin Impact

TO RESTORE FACTORY SETTINGS
These steps will reset your Durkin preferences back to the factory defaults.

1﴿  Close ACT!
2﴿  Go to START‐> MY DOCUMENTS
3﴿  Rename the folder “Durkin Impact V5” to “Durkin Impact V5 BAK”
4﴿  Restart ACT!

To COPY setting from one PC to another
These steps will copy all the setting from one PC to a second PC.

From the good PC
1. Close ACT!
2. Go to START‐> MY DOCUMENTS
3. Copy the folder “Durkin Impact V5” to a server drive

From the secondsPC
1﴿ Close ACT!
2﴿ Go to START‐> MY DOCUMENTS
3﴿ Copy the “Durkin Impact V5” DOWN from the server.
4﴿ Answer yes when it asks you to overwrite.
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Home > Impact Suite > Settings and Options > Settings

Settings
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Home > Impact Suite > Settings and Options > Settings > About

About

The About tab will give information about the registered user of the product and allow administrator users of
ACT to set what modules are seen by users through the Administrator Panel.  
To open the Administrator Panel click the Open Administrator Panel button, to learn more about the
Administrator Panel click here.  
To open the Administrator Panel click the Run ACT! OLEDB Diagnostics button, to learn more about the click
here.
To open the Administrator Panel click the Open Administrator Panel button, to learn more click here.
In the lower right corner is plugin information this will give you information about the Durkin plugins.
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Home > Impact Suite > Settings and Options > Settings > About > Administrator Panel

Administrator Panel

The Administrator Panel lets you set what users will see what modules.  
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A user set as designer will be able to change the modules they see from the modules tab in settings

A user set as runtime will not be albe to change the modules they see.  Only the checked modules on the right
will be available to the user.

A user set as bypassed will not see any Impact Suite Modules
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Home > Impact Suite > Settings and Options > Settings > About > Run OLEDB Diagnostics

Run OLEDB Diagnostics

The OLEDB Diagnostics will run a series of SQL statements against the ACT database.  If you are having issues
with informatin not displaying properly, run this to see if there are any OLEDB issues with ACT.
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Diagnostics Settings

Turning on diagnostics will help the technical support team locate the source of your issues. Many times the issues is a local PC
setting which the tech support team can not reproduce in house. If this is the case please follow these steps to turn diagnostics to
level three on your local PC.

1. Close ACT!
2. Open the folder "C:\Program Files ﴾x86﴿\ACT\Act for Windows\Plugins\'" folder
3. Launch "Durkin.Common.Diagnostics.v5.exe"
4. Set the Level to three and click OK
5. Restart ACT!
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With these diagnostics setting set to level three the diagnostics engine may bring forward a dialog box as shown below. When it
does please click on the [Copy to Clipboard] button, open a new email and paste the error text into the email body. Then send the
email to Support@durkincomcputing.com
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Modules

The Modules tab lets you turn enhance views and tabs, share network preferences and create a stand alone
view outside of ACT.
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There are two ways to change how the modules are shown.

The first way is
1. Install Impact Suite then launch ACT
2. Go to the TOOLS menu and select IMPACT SUITE
3. Check the mode to enhanced to show this view.
4. Clicking the on/off switch will enhance that view under the tab
5. Clicking the multi‐monitor column will show the view in it's own window to move to a separate monitor

The second way is
1. Highlight the module
2. Click the Click here to modify the module's settings button 
3. You can set if the view is enhanced on the left and what tabs are enhanced on the right

To create a stand alone view
1. Highlight the module to create the view from
2. Click Create a stand‐alone view outside of ACT button
3. Type in a the name of the short cut to create on your desktop

To learn more about the Side View click here.
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The shared network preference will share preferences for everyone using database. To turn it on click the Share
Preferences across the network checkbox.
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Tables

The Tables tab shows the custom tables in the database and lets you turn them on/off, enhance tabs and other
settings.

The first way is
1. Install Impact Suite then launch ACT
2. Go to the TOLLS menu and select IMPACT SUITE
3. Change the drop down under Action to ON ‐ enhances this view.
4. Clicking the grey plus signs will enhance that view under the tab

The second way is
1. Highlight the module
2. Click the Click here to modify the module's settings button 
3. You can set if the view is enhanced on the left and what tabs are enhanced on the right
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To create a stand alone view
1. Highlight the module to create the view from
2. Click Create a stand‐alone view outside of ACT button
3. Type in a the name of the short cut to create on your desktop

To learn more about the Side View click here.

The Manage tables button will bring forward a window to add, edit or delete tables.  For more information click
here.

The edit a record in 'list view' will bring up the dataentry form in a new window or in the detail view.

The edit a record in 'details view' will bring up the dataentry form in a new window or in the detail view 

When adding a new record from the contact view has three options for handling how companies are attached
to the new record.  Do not attach contact's company which will just have a contact attached, attach only the
primary company will add just the primary company, and attach all companies the contact is attached to which
attachs all the contacts companies.

Use the extended picker when attaching contacts, companies, groups, and/or opportunities to a custom table
will bring forward a more robust contacts, companies, groups, or opportunities selector.
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Activities

The Activities tab allows custom activity forms to be designed and used instead of ACT activity forms.

To set an activity to use a custom form 
1. Highlight the activity type
2. Click the Use Enhanced button

To design and activity form
1. Highlight the activity type
2. Click the Edit [activity type] button
3. Design the form.  For more information on the form designer go here.

The Manage Activities button will bring forward ACT's Manage Activity Types screen.

Checking the Track cleared activities... will record each time an activity is cleared into a custom table called
ActivityHistory

Checking Activities Tracking Options will intergrate the activities into the choosen custom table.
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Home > Impact Suite > Settings and Options > Settings > Templates

Templates

The Templates tab will set up a link to allow you to add tables, reports, charts, pivots and modules to your ACT
database.  You pick the catagory from the drop down, select the item to install and click install selected [item]
button.

To add a template ﴾aka custom table﴿ please follow these steps:

1. Go to the TOOLS menu and select IMPACT...
2. From this ABOUT form please select the TEMAPLTES tab on the left side.
3. Using the dropdown box at the top please select PROJECT TEMPLATES
4. From the template list please highlight your desired template.

﴾ You can review the templates by clicking on the "Enlarge Preview" ﴿
5. Click on the [Install Selected Template] when you are ready.

You will be presented by a progress bar, sometimes multiple progress bars depending on the template. 
Once the template installation is completed you will be presented with a conformation dialog box.

6. Click OK to close the dialog.

You now have installed custom tables from our base templates. You can modify the tables and or data entry form.
Please check out these help topics:

Custom Tables 

See also
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Home > Impact Suite > Settings and Options > Settings > Math

Math

The Math tab displays a list the math functions.  This screen will let you add, edit and delete contact math
functions.

To create a math function click the new button, and go here for information on editing the math formula.

To edit a math function highlight the math function, click the modify formula button and go here for
information on editing the math formula.

Delete a math function highlight the math function and click the remove formulabutton 

The formula color button will change the background colors for the resulting fields and the fields in the formula
for all the math forumula's

The drop down will display math formula's for the selected table

Math Strip non‐numerics from the field will remove all non‐numeric characters from the all math formula's
when checked.  For example '[address 1] * 5' would be '89 Florence drive * 5' which would cause an error, with
this option checked it would be '89 * 5'.
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Home > Impact Suite > Settings and Options > Settings > Nav Bar

Nav Bar

The Nav Bar tab handles how the Durkin Navbar looks.

 

 

Enhance the Navigation Bar when checked will replace the ACT Navbar with the Durkin Navbar.
Enhance the details tabs with images when checked will add images to the ACT entity detail view tabs.

Geocoding Options
The Edit File button will allow the file to be edited
The Set Default button will set the selected file as the default file to be used for geocoding
The Download from Web button will download new files and updates from DurkinComputing.com
The Add Fields button will add the necessary fields to the current ACT database that are needed for geocoding. 
When the fields are installed the button will become greyed out.
The Update Now button will update all the contacts in the database with information from the geocode files.
The Local Time Zone, Postal Code Lookup & Radius Lookup options are how the Radius will work, the drop
down will set miles or kilometers
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Other

The Other tab is a place to change different options.

Custom Views
When "Rename Act views" is checked the nine views can be  renamed thoughout ACT.

Date Options
Always start up on today's date will start on today's date when checked, when unchecked it will start on the last
selected range.
Only display active users will only show active users in the Scheduled For panel.
Reschedule activities on Task List with key combinations will let you select a single activity or multiple activities
and reschedule them for the future.

 

 

Ctrl + 1 = 1 Day 
Ctrl + 2 = 2 Days
Ctrl + 3 = 3 Days
Ctrl + 4 = 1 Week
Ctrl + 5 = 2 Weeks
Ctrl + 6 = 3 Weeks
Ctrl + 7 = 1 Month
Ctrl + 8 = 2 Months
Ctrl + 9 = 3 Months 
Ctrl + 0 = 1 Year

Report List Options
Group Reports will group the Durkin reports by category
The drop down will change how the Durkin reports are shown Append reports to the bottom of the report veiw will
show both the Durkin and ACT reports, Replace the native reports view will just show the Durkin reports.

On Start up
Will set what page ACT starts on the default, last viewed or select one from the drop down.

Opportunity Options
Attach the current contact when creating a new opportunity will when checked attach the current contact on a new opportunity.
Auto increment the opportunity name field will when checked take the previous opportunity name and numerically increment it.
Enhance product list when checked will enhance the Opportunities product tab, give a custom product entry screen and allow for

Properties

Article ID: other
Views: 229
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 4/9/2014 8:45 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

http://durkincomputing.com/HelpConsole2014/Impact/page.aspx?pageid=product_list
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/other


custom math formula's to be applied to a product.  For more information go here. 

Misc. Options
Hide the "Big Easy" toolbar at the top of ACT will hide the toolbar from view
Add button next to all email fields to access email templates will put a drop down control next to the field that gives access to email
templates. Read More
Add button next to all phone fields to access the phone will put a drop down control next to the field that brings up the phone dial.
Allow users to customize the columns captions will not allow Act users to change the column captions
Touch Scroll ﴾Windows 8﴿ will make the scroll bars larger for fingers and also effect scrolling.

Auto Refresh
Checking Auto Refresh every will refresh all the Durkin views for the amount of time set.
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Home > Impact Suite > Settings and Options > Settings > Other > Email Templates

Email Templates
By turning on the option "Add buttons to email fields to access email templates" Impact will add a new icon next to each email field
in the details view.

This button allows the user to select from a list of email templates. Below is the popup menu when the button is clicked.

To edit the popup menu to include you favorite email templates click on the Edit Templates menu and follow these steps:

1. Click on the Add Existing to the Drop Down
2. Select your template from the open dialog
3. Click the Open button ﴾ ass seen below ﴿ 
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Home > Impact Suite > Settings and Options > Options

Options

The Options button in the toolbar will bring up a window that can change list options, show a pivot table, show
a chart and more.

See also
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Home > Impact Suite > Settings and Options > Options > Columns

Columns

The Columns tab lets you display show total rows and manage your layouts

Create a new layout
1. Click the Create Layout button
2. Enter the name 
3. Click the Save button

Edit a layout
1. Highlight the layout to edit
2. Move columns from/to the available columns/show these columns in this order lists
To add columns from a parent or ACT entity check the check boxes between the lists.

Remove a layout
1. Highlight the layout to edit
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2. Click the Remove Layout button

Duplicate a layout
1. Highlight the layout to edit
2. Click the Duplicate Layout button

The Refresh Captions button will sync up the column names with the ACT fields

Clicking Contact, Company, Group, Opportunity and Parent will allow fields from those tables to be added to the layouts.

Show Columns when unchecked will hide the list view for the custom table.
Show Completed will show entries that have been marked completed
Show Private will show entries that are private
Show one row per record will combine a record that is attached to multiple ACT entities into one row
Show 'Filter Row' will show the filter row above the list to filter each column
Disable panel drag and drop when checked will now allow the column headers to be dragged off the view to remove them.

See also
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Home > Impact Suite > Settings and Options > Options > Chart

Chart

The Chart tab will show a chart on the view, create, edit and delete charts.

Show Chart will make the chart visible.  
Show Caption will put a bar at the top of the chart that will make it draggable
Show Toolbar will make the chart toolbar visible.

Create a new chart
1. Click the Create Create button
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2. Enter the name 
3. Click the Save button

Edit a chart
1. Highlight the layout to edit
2. Click the Modify Chart button
3. That will bring the edit window, for more information go here

Remove a chart
1. Highlight the layout to edit
2. Click the Remove Chart button

Duplicate a chart
1. Highlight the layout to edit
2. Click the Duplicate Chart button

The bottom panel will show what the selected chart will look like.

See also
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Home > Impact Suite > Settings and Options > Options > Pivot

Pivot

The Pivot tab will show a chart on the view, create, edit and delete pivots.
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Show Chart will make the chart visible. 
Show Caption will put a bar at the top of the chart that will make it draggable
Show Toolbar will make the chart toolbar visible.

Create a new chart
1. Click the Create Create button
2. Enter the name 
3. Click the Save button

Edit a chart
1. Highlight the layout to edit
2. Click the Modify Chart button
3. That will bring the edit window, for more information go here

Remove a chart
1. Highlight the layout to edit
2. Click the Remove Chart button

Duplicate a chart
1. Highlight the layout to edit
2. Click the Duplicate Chart button

The bottom panel will show what the selected chart will look like.
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Home > Impact Suite > Settings and Options > Options > Colorize

Colorize

The Colorize tab sets the color rules.  Color rules are designed to colorize records for rows that match a condition. Color rules can
be based on text condition like the one below. In this color rule we are making all rows blue where the word "Triumph" apears in
the MAKE column. 

New Color Rule
1. Click the Create Rule button to insert a new untitled color rule
2. Give the rule a unique name
3. Set what column the condition will match against and the type of comparison
4. Select the date or value the column should match against
5. If you want the whole row to be colored check the aplly color entire row, if not uncheck it and select the column that will be
colored
6. Select the color of the rule
7. Clicking more options will give options for style, gradient and font

Delete Color Rule
1. Highlight the rule
2. Click the Remove button

Copy Color Rule
1. Highlight the rule
2. Click the Duplicate button

To learn more on how color rules are created click here.
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Home > Impact Suite > Settings and Options > Options > Style

Style

The Style tab sets how the list view will look.

Grid Lines
Grid Lines will show default, horizontal, vertical, horizontal & vertical or none.
Style will set the type of line solid, smalldots or default.

Scroll bars
Scrollbars sets when scroll bars will show up none, auto, horizonal, vertical or both.
Autosize sets if the columns will fit on the screen or not by default.

Columns
Show column headers at the top of the list when checked will show the column headers.
Repeat column headers in drill‐down sections when checked will show the column headers for the child tables
each time they appear.  Currently disabled in the product.
Allow drag and drop to remove columns when checked you can drag the column header off of the grid to
remove it from the layout set.
Show child column headers when expanded when checked will show the column headers for the child tables
each time they appear. Currently disabled in the product.

Style
Alternating colors when checked will color every other row in the grid.
Show row headers in first position when checked will show a row header in to the left of the row.
Show record navigator at the bottom when checked will display the number of records and the currently
selected one.
Use hyperlinks in edit mode when checked, will keep hyperlink columns displaying hyperlinks even in edit
mode.

Math Totals
Total Row Position sets if the total row is always at the bottom or if it 

Default Font and Color
Select Font button will open a window to set the font attributes.  The font type, size, style and more can be set.
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Color button will set the font color.

Keyboard Behavior
Enter key behavior when the enter key is pressed the next cell is selected, next row is selected or nothing will
happen.
Other advanced settings brings a window forward to set more advanced settings for how the row is displayed.  

Image SettingsImage Settings
Change image lets you select a new image to be shown in the navigation bar.
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Home > Impact Suite > Settings and Options > Options > Data

Data

The Data tab lets you edit and create data entry forms and edit and create fields for the table.

Data Entry Forms
The Create Form button will create a a new data entry out.  It will ask for the form name and then create it.
The Modify Form button will open the selected form in the designer to make changes.  For more information
on the designer click here.
The Remove Form button will delete the selected form.
The Duplicate Form button will make a copy of the selected form.
The Set as Default button will make the selected form the form that opens when a record is entered or edited.

Data Entry Fields
The Create Field button will create a new field.  For more information click here.
The Modify Field button will edit a field.  For more information click here.
The Remove Field button will delete a field.  For more information click here.
The Field Security button will set permission to edit or view the field.  For more information click here.
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Schedule Side‐by‐side
Columns

TimeLine General Holidays Style

Project

Home > Impact Suite > Settings and Options > Options ­ Calendar

Options ‐ Calendar

The Options button in the toolbar will bring up a window that can change how the calendar displays, the
amount of columns and more.

See also
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Home > Impact Suite > Settings and Options > Options ­ Calendar > Schedule

Schedule

The Schedule tab

Layout for Day and Week View
Work Start wil set when the work day begins.
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Work End will set when the work day ends.
Time Format show time in 12 hour format or 24 hour format.
Day Start will set what time the day starts, must be in one hour increments.
Day End will set what time the day ends, must be in one hour increments.
Hour Format is how the hour is displayed
Timeless will set how many timeless activites to show at once
Increments will set how much each hour is broken down on the calendar, increments range from 5 minutes to
60 minutes.

Layout Work Week and Month View
Hide Time ﴾weekly and monthly﴿ when checked will hide the time from the weekly and monthly calendars.
Hide icons and text ﴾weekly and monthly﴿ when checked will just display the activities and not text or icons in
the activities.
Compress weekends when checked will not show Saturday or Sunday.
Activity height will set the height of activities.
Number of weeks will set the number of weeks shown on the calendar.

Fonts
Daily, Weekly, Work Week and Monthly views each have either own ..., when checked each monthly view can
have it's own font settings.
Screen Fonts will set the font settings for Day/week, weekly, month and day view.
Printer Fonts will set the font settings for Day, week, month and date.
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Home > Impact Suite > Settings and Options > Options ­ Calendar > Side­by­side Columns

Side‐by‐side Columns

The Multi‐Column tab will change how the daily calendar is shown 

0 Tweet

Properties

Article ID: side‐by‐side
Views: 324

https://twitter.com/share


Side‐by‐side Columns 
Single column will display a single column like ACT.
Unique column for each user will make a column for each user, users can be reordered or colored.
Unique column for each resource will make a column for each resource, resources can be reordered or colored.
Unique column for each type will make a column for each activity type, types can be reordered or colored.
Unique column for each priority will make a column for each activity priority, priorities can be reordered or colored.
 
Resource Tracking ﴾requires ACT Premium﴿ is only enabled when unique column for each resource is selected
Display activity in each column... when checked will place the activity in the resource column depending on the first attached
resource, when not checked it will display in resource column for each attached resource.
Create a "None" column for appointments with unassigned resources when checked will place any activity without resources in a
none column.

Here is a screen shot of the multi‐column options set to resources. In this view we are displaying four resources side by side. 
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Home > Impact Suite > Settings and Options > Options ­ Calendar > TimeLine

TimeLine

The Timeline tab will set how the calendar looks in timeline mode.

TimelineScale
Auto adjust timeline for ... when checked will use the default settings if it is unchecked then it will use the
settings below it.
# of navigation tiers on top will display how many time displays to show on the top of the timeline
Interval can be set from second to year.
Frequecny is how often an activity is shown.
Format is how the date is displayed

Timeline Options
Disabe drag and drop of activities when checked will not allow the user to drag activities to change their date
and time.
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General

The General tab 

Work Week Options
Select your days in your work week will set the days that show up in your work week calendar.
First day of the week will set what the first day of the week is displayed default will take ACT's default or you
can choose the day.
First week of the year will set when the new year starts, you can choose Jan1, first 4‐day week or first full week.

Navigation Options
Show week numbers in the navigation calendar when checked will show the week number next to the week in
the smaller navigation calendar that is by default to the right of the calendar.
Change day by dropping onto the navigation calendar when checked will change the current calendar day﴾s﴿ by
clicking on the day﴾s﴿ in the navigation calendar.
Bold dates with activities when checked will bold dates int the navigation calendar that have activities.

Mouse Options
Disable drag and drop of activites when checked will not allow activities to be changed by dragging them to a
new position.
Double clicking schedules a ... when checked will set what type of activity is created when you drag the mouse
on the calendar.
Dragging the mouse schedules a... when checked will set what type of activity is created when you drag the
mouse on the calendar.

Color
Working hours will set the background for work hours in the daily view.
Off hours will set the background for off hours in the daily view.
Week Color will set the background for work hours in the weekly view.
Month Color will set the background for the current month in the monthly view.
Odd Month Color will set the background for the next or previous month in the monthly view.

Popup Options
Use Enhanced Popups when checked will bring a popup the activity when the mouse is hovering over it.
Standard fields when checked will show the standard activity fields.  The font button will change the font
settings.
Extended fields when checked will show the Durkin extended activity fields. The font button will change the font
settings.
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Home > Impact Suite > Settings and Options > Options ­ Calendar > Holidays

Holidays

The Holidays tab displays sets of country holidays on the map and how invitations are handled.  

To display a set of holidays on the calendar put a check box next to the countries to display and select the color
to display the holidays

Invitation Options
Roll‐up invitation status into one activity, when checked will display all the statuses on one activity
Force "Invitations Status" to accepted for all users when multiple users are attached, when checked will mark
ACT users as accepted to invitations
User ACT's "Invitation" status window when editing activity inviatations when checked will use the default ACT
screen.
Display "Accepted" invitations using this color, select color to show with accepted invitations.
Display "Tentative" invitations using this color, select color to show with tentative invitations.

See also

Schedule
Side‐by‐side Columns
TimeLine
General
Style
Project

0 Tweet

Properties

Article ID: holidays1
Views: 186
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/24/2014 1:20 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

 

https://twitter.com/share
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/holidays1


Home > Impact Suite > Settings and Options > Options ­ Calendar > Style

Style
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Home > Impact Suite > Settings and Options > Options ­ Calendar > Project

Project
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Calendar ‐ Fields

Fields will change the look of the activity in the calendar.

To add fields to be displayed on the calendar activity double click the items in the Availble Columns list or select
an item in list and click the add button. Items in the Show these columns in this order will be displayed in the
activity in that order. To change the order select an item and use the Move Up / Move Down buttons to change
the order.

When checked, Contacts checkbox will show Contact fields in the Available Columns list, so they can be shown
in activities. Fields will then be prefaced with the table name.

When checked, Companies checkbox will show Company fields in the Available Columns list, so they can be
shown in activities. Fields will then be prefaced with the table name.

When checked, Groups checkbox will show Group fields in the Available Columns list, so they can be shown in
activities. Fields will then be prefaced with the table name.

When checked, [Project Table Name] checkbox will show Project Table fields in the Available Columns list, so
they can be shown in activities. Fields will then be prefaced with the table name.

Clicking the More Options button will give you more options to set

When checked, Display activity type icons checkbox will display activity type icons in the activities. Max number
of icons for an activity is 4.

When checked, Display invitation status icons checkbox will display the invitation status in the activites. Max
number of icons for an activity is 4.

When checked, Display secondary icons checkbox will display secondary icons in the activities. Max number of
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icons for an activity is 4.

When checked, Display Activity Series checkbox icons will display the series icons in the activities. Max number
of icons for an activity is 4. This will slow down refreshes.

When checked, Display Project icons checkbox will display the project tables icon in activities associated with it.
Max number of icons for an activity is 4. This will slow down refreshes.

When checked, Each field displays on its own line checkbox will show one field per line in the activities. 

Separate fields using this character ﴾ ﴾none﴿, |, :, ‐ , +, =﴿ will divide each field with the selected character when
Each field displays on own line checkbox is not checked.

When checked, Compress blanks will ignore a blank field and move the next non‐blank field up to fill the line.
This is available when Each field displays on own line checkbox is not checked.

When checked, Replace MyName with "Regarding" checkbox will take out the current MyRecord user and
replace with the Regarding field in the activities.

When checked, Display field labels using this many letters checkbox will put the first [selected number] letters
of the field name before the contents of the field.

Display these contacts handles how Scheduled With will display in the activities ﴾ Contacts and Users, Contacts
First then Users, Contacts Only, Users First then Contacts, Users Only ﴿.

Display in this order: is the field that Scheduled With will be sorted on.

See also
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Home > Impact Suite > Settings and Options > Calendar ­ Color Rules

Calendar ‐ Color Rules

Color rules are designed to colorize records for rows that match a condition. Color rules can be based on text condition like the
one below. In this color rule we are making all rows blue where the word "Triumph" apears in the MAKE column.

 

When Apply color rules to task list is checked the calendar color rules will over be used for task, instead of the current task list color
rules.

New Color Rule
1. Click the Add button to insert a new untitled color rule
2. Give the rule a unique name
3. Set what column the condition will match against and the type of comparison
4. Select the date or value the column should match against
5. If you want the whole row to be colored check the aplly color entire row, if not uncheck it and select the column that will be colored
6. Select the color of the rule
7. Clicking more options will give options for style, gradient and font

Delete Color Rule
1. Highlight the rule
2. Click the Remove button

To learn more on how color rules are created click here.

See also
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Home > Impact Suite > Filter Panels

Filter Panels

See also
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Home > Impact Suite > Filter Panels > Date Range Panel

Date Range Panel

At the lower left corner of all most views you will find the date selector list. You can use this list to quickly filter
your rows by a date range. This is much like native ACT's date‐range selector in the Task List but with a little
more power. Our date range selector allows you to select which date field you want to filter. 
By default the date is the "Created Date" field but you may want to filter on your own custom field like "Project
Start Date" or the "Sold Date" from the Automobile demo table. To show by "SoldDate" click on the drop
downlist and select "Sold Date"

With your new setting, try selecting a different date range from the list. Remember that you are now filtered on
that date field and if you have not entered any dates in any record then no record will match and your list will
be empty 

For the Calendar Module the date range panel switches between the day, work week, weekly and montly views.

See also
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Home > Impact Suite > Filter Panels > Record Manager Panel

Record Manager Panel

The Record Manger panel allows you to show entries based on the record manager of the entry.

Clicking on the drop down you can chose Select All, Select None or choose a team to display.  The Task and
Calendar Modules do not have the drop down list.

See also
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Home > Impact Suite > Filter Panels > Picklist Panel

Picklist Panel

The Pick list panel 1 & 2 allows you to filter based on a field with an attached drop down list.

To set up the picklist panel select the field from the drop down.

Right clicking on the panel you can chose Select All or Select None to show all the record mangers or none. 

See also
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Home > Impact Suite > Filter Panels > Color Rules Panel

Color Rules Panel

The Color Rules Panel shows the color rules you have made.  Rules with the boxes checked are turned on, those
without checks will not be colored.  To turn on or off a color rule click the box.  To edit the color rules double
click on the panel to bring up the designer, click here for more information.

See also
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Home > Impact Suite > Filter Panels > Types Panel

Types Panel

The Types Panel shows the activity types in the ACT database. Types with the boxes checked are turned on,
those without checks will not be displayed. To turn on or off a type click the box. 

This is only on the Calendar and Task Modules.

See also
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Home > Impact Suite > Filter Panels > Priority Panel

Priority Panel

The Priority Panel shows the priorities you have made. Priorities with the boxes checked are turned on, those
without checks will not be displayed. To turn on or off a priority click the box. 

This is only on the Calendar and Task Modules.

See also
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Home > Impact Suite > Filter Panels > Scheduled For Panel

Scheduled For Panel

The Scheduled For Panel shows the users in your ACT database. Users with the boxes checked are turned on,
those without checks will not be displayed. To turn on or off a user click the box.

This is only on the Calendar and Task Modules.

See also
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Home > Impact Suite > Filter Panels > Resources Panel

Resources Panel

The Resources Panel shows the resources in your ACT database. Resources with the boxes checked are turned
on, those without checks will not be displayed. To turn on or off a resource click the box.

This is only on the Calendar and Task Modules.

See also
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Home > Impact Suite > Filter Panels > Options Panel

Options Panel

The Options Panel gives quick access to options dealing with activities. Checked boxes are turned on, those
without checks will not be displayed. To turn on or off an option click the box.

Show private will show private activities.
Show cleared tasks will show cleared tasks.
Show Outlook tasks will show tasks from Outlook.
Use ACT's internal color will display the color scheme set in ACT.
Hide timeless will not display the timeless activities on the view.

This is only on the Calendar and Task Modules.

See also
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Create Pivot Edit Pivot

Home > Impact Suite > Pivot Table

Pivot Table

A Pivot grid represents dynamic data (obtained from an underlying data source) in a cross­tabulated form to
create cross­tab reports , similar to Pivot Tables in Microsoft Excel®. Column headers display unique values
from one data field, and row headers ­ from another field. Each cell displays a summary for the
corresponding row and column values. By specifying different data fields, you can see different totals. This
allows you to get a compact layout for a complex data analysis.

See also
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Home > Impact Suite > Pivot Table > Create Pivot

Create Pivot

To start a Pivot click on the Create Pivot button in the Pivot Options window.

Type in the Pivot name

See also

Edit Pivot
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Home > Impact Suite > Pivot Table > Edit Pivot

Edit Pivot

To change a pivot select the pivot to modify in the Pivot Options window and click the Edit Pivot button 

This will bring up the Pivot Designer. 

Checking The fields in the list will make them available in the pivot grid.  The fields in the Filter Area, Row Area,
Column Area and Data Area boxes can be dragged between the boxes to change what areas the field will show
up in.

See also

Create Pivot
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Chart Wizard Create Chart Edit Chart

Home > Impact Suite > Chart

Chart

See also
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Home > Impact Suite > Chart > Chart Wizard

Chart Wizard

The Chart Wizard gives more advanced and granular options for the chart
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See also



Create Chart
Edit Chart

 

Home > Impact Suite > Chart > Create Chart

Create Chart

To Create a chart click on the Create Chart button in the Chart Options window.

Type in the Chart name

See also

Chart Wizard
Edit Chart
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Home > Impact Suite > Chart > Edit Chart

Edit Chart

To change a chart select the chart to modify in the Chart Options window and click the Edit Chart button 

This will bring up the Chart Designer.  Changes made in the designer will show up in real time on the chart next
to the options.

Chart Title when checked will display the text at the top of the report.
Legend when checked will show a legend for each series.
Type will change the type of chart that is displayed.
Palette will change the color of the bars and the background.
Field will be the table field that is in the chart
Value will count, sum, average, min or max the field
Scale is how to display the field
Width is how to display the time
To get to more advanced options click the Chart Wizard button, to learn more about the wizard click here.

See also

Chart Wizard
Create Chart
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Tables Define Fields and
tables

Table Wizard Forms Designer Advanced Functions Controls on Forms

Field Designer Table Designer Tab Order on Detail
View

Home > Impact Suite > Tables and Forms

Tables and Forms

This section describes the features and function to create a custom table and design the data‐entry form.

 

To design a new custom table please read Tables 

To add, remove or change fields in a custom table please read: Define Fields and tables 

To import a table from a template please read: Table Wizard 

To design the data entry form please read: Forms Designer 

For a list of the controls you can add to a data entry form please read: Controls on Forms 

See also
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Home > Impact Suite > Tables and Forms > Tables

Tables

This section describes how to add custom tables into your ACT database. 

Create a table
Rename a table
Import structure
Export Structure
Delete Table
Table Image and Calendar Options

Add a table manually
Add a table from a table from a  file
Add a table using the table wizard 

This section describes how to import data from an Excel spread sheet ﴾*.XLS or *.XLSX﴿  or an XML formatted file.

Import data from excel into a custom table

See also
Define Fields and tables
Table Wizard
Forms Designer
Advanced Functions
Controls on Forms
Field Designer
Table Designer
Tab Order on Detail View
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Home > Impact Suite > Tables and Forms > Tables  > Create a table

Create a table

Adding custom tables allows you to track information that would have been well‐nigh impossible with
native ACT!. Custom tables can include invoices, events, household items or inventory etc. 

There are two ways to create a custom table: 

Use a table template that includes multiple fields.
Design your table from scratch, by adding your own field list.

For more information please see: Your First Custom Table 

To add a custom table follow these steps:

1. In ACT! go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Click on the CREATE TABLE button
3. Enter the name of the custom table in the window.
4. Click on the SAVE button

By default here are a few system field which are automatically added to your new custom table. These
fields include: Edit Date, Created Date, Completed,  Last Edited By, Parent EntityID, Parent Entity
Name, Record Creator and Record Manager.
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Once the table has been created you can add you desired field by clicking on the Create Field link
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Delete a table

To delete a custom table follow these steps:

1. In ACT! go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Select the table to delete, from the custom table drop down
3. Click on the DELETE TABLE button
4. Enter Act Credentials
5. Confirm table deletion
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Displaying all records
Once you have created your own custom table the list of records from this table can be display in many places and in many formats
such as; list views, charts and pivot tables.

Lets say you created a custom table named "Service Calls" there are two places you would like to see your service call records:

1. In a mater list ﴾ All records ﴿ which displays all the service call records in the current database.
2. In a minor list which displays only the service calls attached to the current contact, company, group or opportunity.

To turn on the master list using ACT's native navigation bar follow these steps:

1. Go to the TOOLS menu and select IMPACT...
2. Select the TABLES section from the left tab
3. Place a check mark in the MODE column ﴾ it will now read "Enhanced" ﴿
4. Click the OK button

To turn on the master list using Impacts new navigation bar follow these steps:

1. On the navigation bar click on the ARRANGE link ﴾ its just below the 'Search' icon ﴿
2. Select your desired table from the list on the left
3. Click on the ADD button to move it to the right side
4. Click on OK button to close

 
On this form you can set the position of the icons by using the 'Move Up' and 'Move down" buttons.  You can also the the icon
image by clicking the "Change Image" button. For best results the image should be 32 x 32 pixels.
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Adding the table to the navigation

Once you have added a custom tables to your act! database you can add a short cut to the navigation bar on the left side. By
default Impact replaces the native act! with an enhanced NavBar ﴾naviation bar Read more ﴿ which includes short cuts
to custom tables. 

To add a custom table shortcut follow these steps:

1. On the enhanced NavBar click on the Arrange text

2. From the popup from add the custom table to the list on the right side

You can also change the icon or picture using the "Change Image" button.

3. Click the OK button to close
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Displaying records on a tab

To display records from a custom table on a tab you need to turn ON the option for each details view in ACT!.

When you add a custom table all four detail view tabs are on by default. These include; contacts, companies, groups
and opportunities. ﴾ as shown below﴿ To turn of the custom table tab for any one of these sections follow these steps:

1. In ACT go to the TOOLS menu and select IMPACT...
2. Click on the TABLES section
3. Click on the icon on the column you want to change. 

The indicator should change from ON to OFF
4. Click on OK

By default the tabs are positioned at the end of the tab row. To re‐position you can manually create a tab in the ACT
layout designer. Please follow these steps to position the tab on the far left or first position.

1. In ACT go to the TOOLS menu and select DESIGN LAYOUT ‐> CONTACT
2. Use the mouse to select the tab control at the bottom of the layout
3. Click F4 on the keyboard to open the Properties window
4. Click on the ellipse icon [...] next to "Edit Tabs   ﴾Collection﴿" 
5. Click on the ADD TAB button
6. Enter the tab name ‐ NOTE ‐ Must use the same name as the custom table.
7. Click OK to save the new tab which should now appear in the list.
8. You can use the "Move Up' or 'Move Down' buttons to position the tab
9. Go to the FILE menu and select SAVE

10. Go to the FILE menu and select EXIT
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Displaying In‐Line Components

When you create a new custom table you can display this information almost anywhere on the contact details view.  By default when
you add a custom table it creates a new tab at the end of the tabs. This default option always forces the list to fill the entire tab. You
may want to have the list only fill half the tab or even display the lisy above the tabs next to the contact name.  For either
of these solutions follow these steps:

1. In ACT go to the TOOLS menu and select DESIGN LAYOUT ‐> CONTACT

2. Click on the "Custom' toolbar in the upper right side.

NOTE  * The first time after install Impact you need to add your new custom controls to the custom toolbox. 
To do this right click on the toolbox and select CUSTOMIZE from the popup menu.
When the 'Customize Toolbox" window opens place a check mark in all the entries and click OK

3. Select the "Impact Custom Tables' component

4. Using the mouse drag a rectangle on the area you wish the component to reside. 
Pictured below we have dragged the PROJECTS table into the lower left corner of a tab named Projects. 
Note that you can now add addition contact field to the same tab page.
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5. You can add the component to the top section above and outside of a tab. This is very useful if you want the information to
be top level. Otherwise if its on a tab the users will need to click to open the tab each time. Having the component at the top
eliminates the extra mouse click

6. Go to the FILE menu and select SAVE

As an added bonus you can add list from other native ACT tables such as activities, histories, notes and/or opportunities.

See also

Create a table
Delete a table
Displaying all records
Adding the table to the navigation
Displaying records on a tab
Displaying In‐Line Native Lists Charts
Change Table Name
Import a table
Duplicate a table
Import template
Export template
Delete table
Import Records into Custom Tables
Create Parent Child Relationships



 

Home > Impact Suite > Tables and Forms > Tables  > Displaying In­Line Native Lists Charts

Displaying In‐Line Native Lists Charts

As in the previous help topic about displaying custom table in line you can also display some of ACT's native tables such as notes,
histories, activities and/or opportunities above the tabs.  To display a native table on the top of the details view follow these steps:

1. In ACT go to the TOOLS menu and select DESIGN LAYOUT ‐> CONTACT

2. Click on the "Custom' toolbar in the upper right side.

NOTE  * The first time after install Impact you need to add your new custom controls to the custom toolbox. 
To do this right click on the toolbox and select CUSTOMIZE from the popup menu.
When the 'Customize Toolbox" window opens place a check mark in all the entries and click OK

3. Select your desired component from the toolbox and using your mouse drag an area you want the list to appear.
In this picture we have added five lists to the top section of ACT!

4. Go to the FILE menu and select SAVE then EXIT

In this picture we see the results of our new design. Each component has the ability to display the records in one of three
styles: List view, as a chart or in a pivot table. To change style simple use the smart Tag in the upper right corner of the
component. You can change styles on the fly without going back into the designer.
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Change Table Name

Sometime when you create a table you give is a descriptive name such as 'Serial Numbers' but realize a shorter name is more
appropriate for the interface such as "SN" ﴾ Especially when it appears on the left navigation icons.﴿

To change the name of an existing table follow these steps:

1. In ACT go the the TOOLS menu and select IMPACT
2. Click on the TABLES tab on the left side
3. Select your desired table
4. Click on the "Click Here to modify the tables's setting' button
5. On this 'Options'; form change the 'Display Name" of the table
6. Click on the OK button.
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Import a table

Import table function uses a pre‐defined table structure file to create a new table. Inside this DTB file is a list of
fields which. These fields once imported can be added, removed or altered.

ACT Data Scheme Template ﴾*. DTB﴿

To import a table using a DTB file please follow these steps:

1﴿ In ACT! go to the TOOLS menu and select DEFINE CUSTOM TABLES
2﴿ Click on the IMPORT TEMPLATE link
3﴿ Select the ZIP file that contains the DTB file, from your hard drive
4﴿ The default name is the new custom table is the name of the DTB file. You can change this name.
5﴿ Click on the IMPORT button
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Duplicate a table

To Duplicate your custom table under a new name follow these steps:

1. Go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. From the drop down select the table you which to export ﴾ copy ﴿
3. Click on the “Export Template” link under the TABLES panel on the left side
4. Give the file a unique name such as the name of the new table you want to create then click SAVE
5. Click on the “Import Template” link under the TABLES panel on the left side
6. Select the file you saved
7. By default the new table name will be the name of the file but you can change it at this time.
8. Click on the SAVE button when you are completed.
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Import template

Import table template function uses a pre‐defined table structure file to create a new table. Inside this DTB file is
a list of fields which. These fields once imported can be added, removed or altered.

ACT Data Scheme Template ﴾*. DTB﴿

To import a table using a DTB file please follow these steps:

1﴿ Click on the IMPORT TEMPLATE link
2﴿ Select the DTB file from your hard drive
3﴿ The default name is the new custom table is the name of the DTB file. You can change this name.
4﴿ Select the top level entities this custom table is attached to.
5﴿ Click on the SAVE button
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Export template

Export table template function saves the fields in the current custom table in a file. You can use this file to
import the table into a different database or into the same database under a different custom table name.

ACT Data Scheme Template ﴾*. DTB﴿

To export a table into a DTB file please follow these steps:

1. Select your desired table to export
2. Click on the EXPORT TEMPLATE link
3. On the SAVE DIALOG enter your DTB file name 
4. Click SAVE
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Delete table

Delete table function deletes the table and all records in the custom table. This action is non reversible and
completely removes the custom table from your ACT database. The only way to retrieve this information is to
restore an ACT backup file.

To delete a table from your database follow these steps:

1. Go to the tools menu and select DEFINE CUSTOM TABLES
2. Select your desired table from the drop down
3. Click on the DELETE TABLE link
4. For additional security you are asked to re‐enter your credentials
5. Click on the YES button when prompted.
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Import Records into Custom Tables

There are two ways to import records into a custom table 1﴿ import using the wizard to all contacts, companies,
groups or opportunities 2﴿ single import is used for importing into one contact, company, group or
opportunity.

The best use for the wizard is import many records to many contacts, companies, groups or opportunities in
Act.  For example this would be used to import 300 invoices for 50 contacts in Act.  For more information click
here.

The best use for the single import is many records to a single contact, company, group or opportunity.  For
example this would be best to import 50 car sales for a contact in Act.  For more information click here.
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Import from Excel for all Contacts

This section describes how to import data from an Excel spread sheet ﴾*.XLS, *.XLSX, *.XML or *.CSV﴿ or an XML formatted file. 

To access the Import Wizard open the FILE menu and select "Import into custom table..." The 'Import Wizard" form will open. Click
on the NEXT button to get to STEP 1.

STEP 1
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1. Click on the BROWSE button to select your file to import. File formats supported are XLS, XLSX, CSV and XML.
2. Using the SHEET drop down select which sheet to import.
3. Click on the NEXT > button to continue to Step 2. 

STEP 2

Top level table: Contact Company , Group or Opportunity

1. Using the "ACT Table Name" drop down select which top level table to attached these new record to.
You must select either; contact, company, group or opportunity.

2. Using the drop down select the "Action to be performed if the source matches destination". Do not change will not change the
parent entity field, change will update the field

3. Check 'Attach import record to all entities found' will attach all attach the imported data to all contacts, companies, groups or
opportunities that match the search criteria

4. Using the "Custom Table Name" drop down select which custom table you are importing into. This will display all the custom
tables in the current database.

5. Using the drop down select the "Action to be performed if the source matches destination" Do not change will not change the
parent entity field, change will update the field

6. Click on the NEXT > button to continue to Step 3
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STEP 3

By default the import engine will match like fields from the Excel file to fields in the parent and custom table.. So if you Excel
headers match all the fields in your custom table then. If the 'Table Fields' column is blank you need to use the drop down to select
the fields in the custom table to map to.

If the custom table has a date field called "Imported_Date" you can check the Stamp today's date into Import_Date field, the import
date will be stamped into that field during the import.

You can save and recall maps by using the "Save Map" and "Load Map" buttons. Maps are stored in an XML file format on your
hard drive.

1. Select the desired fields to map to.

2. Select the KEY fields 
    These are the fields which the import will match on when looking up the record in the database.

3. Click on the IMPORT NOW button to start the import process.

 

When you click on the IMPORT NOW button you will be presented with a progress bar indicating the amount of work completed.
When the import has finished you will receive a confirmation dialog. Click OK to close the import wizard.
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Import from Excel for single contact

Importing an Excel file to a single contact is simple and easy.

1. Click the Import Excel button in the tab toolbar

2. A window will say you are about to import a file, click yes to continue.
3. Select the File to import
4. A simple version of importer will come forward.  If you have imported before it will pick up the previous
settings.

5. Pick the sheet from the Excel file.
6. If you want to replace any records already attached to the current ACT entity choose replace with source from
the data overwrite options and select a sub entity key to match the records on.
7. Pick the table field from the drop down to match with the excel fields.
8. Click Import
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Create Parent Child Relationships

To create parent child relationships with records already entered into custom tables

1. Click File > Create parent‐child relations...
2. Set the parent table
3. Set the key for the parent table
4. Set the child table
5. Set the key field for the child table
6. Click the process button to relate the tables

 

The overwrite checkbox will if checked create the relation if a match if found, if unchecked it
will create the relation if there is a match and the parententityname & parententittyid fields
are blank.  
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Define Fields and tables

This section show you how to add or change a custom table 
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Fields:

Create field
Edit Field
Delete field

Tables:

Create a table
Import a table
Duplicate a table
Import Template
Export Template
Delete Table

Layouts:

Open layout  
Create layout 

Wizards:

Template wizard
Table wizard
Import template
Export template
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Table Wizard
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Add a New Field

To add a new field into the custom table click on this link.

This Define Fields form comes forward when you are adding or editing field.  

Field Name
The display name used in the interface

Alias 
The name in the SQL database ﴾ This can not be changed ﴿

Allow Blank 
Allow the user to leave the field empty.

Generate History
Create a history record when this field changes.

Primary Field
Is this a primary field.

Use drop‐down list
Is there a drop down list the users can select from when doing data entry.

Default value ﴾ Auto Fill  or Auto Populate ﴿
The default value can be any text string or the default value can be automatically filled/populated from the parent record. Below we
are populating the field using the value from the Contact's ID/Status field.

If you want to display the Contacts ID/Status field on the data‐entry form without creating a field in the child table please read
see Add contact field onto the form 

Field Format
The format string used to format the data entry pattern such as phone numbers.
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Field Length
The maximum length of characters which can be entered into this field. In the old DOS/DBF days you always tried to make this the
smallest number possible. In today's SQL driven data back ends it is not as critical to performance.
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Change a Field

To change a field in the custom table click on this link.

This Define Fields form comes forward when you are adding or editing field.  

Field Name
The display name used in the interface

Alias 
The name in the SQL database ﴾ This can not be changed ﴿

Allow Blank 
Allow the user to leave the field empty.

Generate History
Create a history record when this field changes.

Primary Field
Is this a primary field.

Use drop‐down list
Is there a drop down list the users can select from when doing data entry.
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Default value ﴾ Auto Fill  or Auto Populate ﴿
The default value can be any text string or the default value can be automatically filled/populated from the
parent record. Below we are populating the field using the value from the Contact's ID/Status field.

If you want to display the Contacts ID/Status field on the data‐entry form without creating a field in the child
table please read see Add contact field onto the form 

Field Format
The format string used to format the data entry pattern such as phone numbers.

Field Length
The maximum length of characters which can be entered into this field. In the old DOS/DBF days you always
tried to make this the smallest number possible. In today's SQL driven data back ends it is not as critical to
performance.
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Remove a Field

To remove a field from a custom table follow these steps:

1﴿ Highlight your desired field
2﴿ Click on the Delete Field link 
3﴿ Confirm the field deletion dialogue box

See also
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Define Fields
Phone and Email Fields
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Define Fields

This Define Fields form comes forward when you are adding or editing field.  

Field Name
The display name used in the interface

Alias 
The name in the SQL database ﴾ This can not be changed ﴿

Allow Blank 
Allow the user to leave the field empty.

Generate History
Create a history record when this field changes.

Primary Field
Is this a primary field.

Use drop‐down list
Is there a drop down list the users can select from when doing data entry.
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Default value ﴾ Auto Fill  or Auto Populate ﴿
The default value can be any text string or the default value can be automatically filled/populated from the
parent record. Below we are populating the field using the value from the Contact's ID/Status field.

If you want to display the Contacts ID/Status field on the data‐entry form without creating a field in the child
table please read see Add contact field onto the form 

Field Format
The format string used to format the data entry pattern such as phone numbers.

Field Length
The maximum length of characters which can be entered into this field. In the old DOS/DBF days you always
tried to make this the smallest number possible. In today's SQL driven data back ends it is not as critical to
performance.
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Phone and Email Fields

Custom tables support all the same field as ACT with these two exceptions:

Phone Fields
Email Fields

Both Phone and Email fields are not supported in custom tables. To create a phone field add a character field
then set the format "﴾999﴿999‐9999" on the second panel of the Define Fields form.
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Table Wizard

This section described various options to manage your custom tables

Table Wizard
Template Wizard
Import Templates
Export Template

See also

Tables 
Define Fields and tables
Forms Designer
Advanced Functions
Controls on Forms
Field Designer
Table Designer
Tab Order on Detail View

0 Tweet

Properties

Article ID: table_wizard2
Views: 179
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/24/2014 1:37 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

 

Home > Impact Suite > Tables and Forms > Table Wizard > Table Wizard

Table Wizard

The Table Wizard will guide you through the creation of custom table﴾s﴿.  

1.  Choose the table to create from the list on the left and click the next button

2.  The tables that will be installed will be displayed.  Click Install Now to create the table﴾s﴿.
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3.  A window will show the progress of the table﴾s﴿ creation.  When finished a window will say the install in
finished.

See also
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Export Template
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Template Wizard

The Template Wizard will guide you through the creation of custom table﴾s﴿.  
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1.  Choose the table to create from the list on the left and click the next button

2.  The tables that will be installed will be displayed.  Click Install Now to create the table﴾s﴿.

3.  A window will show the progress of the table﴾s﴿ creation.  When finished a window will say the install in
finished.
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Import Template

You may be working with your consultant or just need to move a custom table from one database to another.
You can import and export tables.  You can import table structure, data entry forms, column layouts, color rules,
math functions, Word templates, ACT templates, toolbars and picklists.  Zip files need to have been exported
with Impact Suite version 5 to include picklists.

To import existing table fields follow these steps:

1. Go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. At the bottom of the window click on the IMPORT TEMPLATE button
3. Choose the zip file containing the table to import
4. Click on the IMPORT button at the bottom of the form.

See also

Table Wizard
Template Wizard
Export Template
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Export Template

You may be working with your consultant or just need to move a custom table from one database to another.
You can import and export tables.

To export existing table fields follow these steps:

1. Go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Click CREATE TEMPLATE
3. Check your desired table﴾s﴿ to export.
4. Set a password if one is needed.
5. Select the parts of the custom table to export.
6. At the bottom of the window click on the EXPORT button
7. Give the file a unique name and SAVE it on your hard drive.

Now you can copy or email this file to another computer to import this custom table.
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Forms Designer

The designer is comprised on 5 main areas listed below. 

1. Toolbar and menus
2. Designer Surface
3. Toolbar Panel
4. Properties Panel
5. Math Functions Panel

  
As you design and modify the user interface of your custom table records, you will need to add, align, and position controls.
Controls are objects that are contained within the form. Each type of control has its own set of properties, methods, and events that
make it suitable for a particular purpose. You can manipulate controls in the designer by moving them around or changing there
properties to behave in a different fashion.

Tags: Data entry designer, data‐entry designer, custom table designer, design layouts
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Adding a new field Add contact field
onto the form
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the form

Changing Fonts and
colors

Adding a child table

Scripting using Visual
Basic

Home > Impact Suite > Tables and Forms > Forms Designer > Fundamentals

Fundamentals

Using our data‐entry forms designer you can create unique data‐entry forms fro your required business needs.
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Editing a data‐entry form

You can edit the data‐entry form by opening it in the forms designer. 

There are two ways to open the forms designer.

1﴿  In the list view click on the options button in the toobar, click on the data tab, select the data entry form from
the list and click the modify form button

2﴿ Open the data entry form and click the design button in the toolbar.
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Adding a new field

A new field can be added from the Field ‐ New or from the ACT menu system. 
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Add contact field onto the form

Sometime you need to add a field from the contact table onto the data entry form. On the screen shot below we are displaying the
BILL TO and SHIP TO fields directly from the attached contact. This gives you more flexibility when doing data entry since you can
confirm contact information.

To add a contact field

1﴿ Open the form in the form designer. See Editing a data‐entry form for more information.

2﴿ Using the controls drop down select List ‐ Parent Tables

Using the designer you can add fields from the parent table ﴾contact, company, groups or opportunities﴿ directly onto the data‐
entry form of the custom record. This parent field will be in read‐only mode.

See also

Editing a data‐entry form
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Changing Fonts and colors
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Scripting using Visual Basic
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Add Parent field onto the form
​Sometime you need to attach a record to a record in another custom table such as Time Billed attached to a record in the
Project table or Transactions into the Accounts table. To do this you need to add the custom control onto your data entry
form. This control is called "Single Line Custom Parent"

In the screen shot we are displaying the Account Number and other account fields in the data entry form for the transfer
record.

To add a field from a parent table

Open the form in the form designer. See Editing a data­entry form for more information. On the top toolbar click on the Parent Child
Lists icon to access the controls.

1. Drag the Single Line Custom Parent onto your form. 

2. Select the desired custom table.

3. Select the desired field.

4. Click OK 
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Note‐ All parent fields will be in read‐only mode. To change the values in any field you need to click on the Lookup button and
select a different record.

These controls are made up of three elements.

1. The Text box
2. The Navigation button 
3. The Look up Button

You can turn off the Navigation button and the Look up Button to de­cluttered the form if you have multiple controls.
Below we have five controls which display multiple fields from the attached contact. WE left only the first "Contact Name" control
with buttons.
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Changing Fonts and colors

The font change window ﴾below﴿ will change the font features for control and can be accesed two different
ways
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Using the Quick Properties
Click the 'select font' button and you can change the font type, font style, font size, font color and effects in the
font window.

Using the .Net Properties
Click the elipses ﴾...﴿ button in the font property and you can change the font type, font style, font size, font color
and effects in the font window.
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Adding a child table

To add a child table onto a parent table data‐entry form please follow these steps:

1. Open the parent data‐entry form
2. Change the Controls to "LIST ‐ CHILD TABLES"
3. Drag your desired child table onto the layout
4. Click Save then close the designer
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Home > Impact Suite > Tables and Forms > Forms Designer > Fundamentals > Scripting using Visual Basic

Scripting using Visual Basic

The button [dynamic] control accepts Visual Basic scripting to update fields, save fields and more.  For more
information go here Button [Dynamic]

See also

Editing a data‐entry form
Adding a new field
Add contact field onto the form
Add Parent field onto the form
Changing Fonts and colors
Adding a child table

0 Tweet

Properties

Article ID: scripting_using_visual_basic

Views: 166
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/24/2014 1:39 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

 

http://durkincomputing.com/HelpConsole2014/Impact/page.aspx?pageid=button__dynamic_
https://twitter.com/share
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/scripting_using_visual_basic


Home > Impact Suite > Tables and Forms > Forms Designer > Toolbars

Toolbars

Below are the toolbars and what the items do

1. Save the form
2. Cut, copy & paste controls
3. Show or hide the properties or the toolbox
4. Add a new field
5. Add a new table
6. Show or hide the math at the bottom
7. Show the frame around the dataentry window
8. Show the Fields toolbox
9. Show the New Fields toolbox

10. Show the Panels toolbox
11. Show the Lists toolbox
12. Show the Controls toolbox
13. Show the Buttons toolbox

1. Align a group of controls horizontally to the left, center or right
2. Align a group of controls vertically to the top, center or bottom
3. Make controls the same width, height or both
4. Make the horizontal spacing between selected controls the same, increase the space, decrease the
space or remove the space

5. Make the vertical spacing between selected controls the same, increase the space, decrease the space
or remove the space

6. Center the selected controls vertically or horizontally
7. Brings a control to the top or pushes it to the back
8. Sets the tabbing order for the form.  Click the menu item to start the the mode, click the controls in
the order you want to set the tab and click the menu item again to end the mode.

See also
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Home > Impact Suite > Tables and Forms > Forms Designer > Designer Surface

Designer Surface

This section display the controls and visual elements on the data‐entry form.  You drag controls onto the form
and layout how the data entry screen will look.
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Home > Impact Suite > Tables and Forms > Forms Designer > Toolbox Panel

Toolbox Panel

This panel holds the controls which can be added onto the designer form. The controls are organized under eight sections. To
display each section please use the drop down at the top of the toolbox panels.

1. Fields ‐ Existing
2. Field ‐ New
3. List ‐ Child Tables
4. List ‐ Parent Tables
5. Controls container
6. Controls Generic
7. Controls Specialized
8. Code Snippets
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Home > Impact Suite > Tables and Forms > Forms Designer > Properties Panel

Properties Panel

The properties panel can be changed from it's default of quick properties to ACT! properties or .Net Properties.

The quick properties will display the basic and most changed properties for a control
The .Net properties will show all the properties for a control
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Home > Impact Suite > Tables and Forms > Forms Designer > Properties Panel > Read Only Property

Read Only Property

To add field security to a control follow these steps

1. Select the control
2. Select ReadOnly in the properties panel click the elipses button [...] in the property window
3. Check the "Make this field Read‐Only..." box
4. Select the users and/or teams that can edit the field
5. Click the ok button

See also
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Home > Impact Suite > Tables and Forms > Forms Designer > Math Functions Panel

Math Functions Panel

The math function panel shows all of the math functions for a custom table, from this screen you can view and
edit the functions.  You can edit a math function by double clicking it or selecting it and clicking the modify
button, for more information on editing a math function click here.

1. The order in which the math functions will be run
2. Weither the math function will be run
3. The name of the math function
4. The field the math function will return a value to
5. The fields that make up the function

See also

Fundamentals
Toolbars
Designer Surface
Toolbox Panel
Properties Panel

0 Tweet

Properties

Article ID: math_functions_panel
Views: 195
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/24/2014 1:39 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

 

https://twitter.com/share
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/add_field_security
#_Anchor_math_functions
https://twitter.com/share
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/math_functions_panel


Auto‐Select Tabs Run Custom
Compiled Code

Home > Impact Suite > Tables and Forms > Advanced Functions

Advanced Functions

On some controls there are function and properties which can change the behavior of the control. This section
will document these advanced functions.
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Auto‐Select Tabs

You can add a tab control onto your form which is triggered by the user selecting a value from a drop down
list. 

1. Add a tab control onto your form
    1. Drag and drop the Tab Control from under the Controls ‐ Container toolbox  
    2. Click the Open Collection button in the properties panel
    3. Click the ADD button
    4. Change the ﴾Name﴿ property to the name in the drop down list you are going to attach below.When you
run the form, tab pages will be automatically selected when the value of the drop down list changes and
matches the name of tab name. In the example we are creating three tabs named:

‐ Residential
‐ Commercial
‐ New Construction 
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2. Add a Drop down control onto your form
    1. Drag and drop the Drop Down Lookup from under the Controls ‐ Specialized toolbox 
    2. Using the TabControlName property drop down select the tab control.
        You will see multiple tab control names if multiple tab controls are on the form
    3. Verify the Custom Table and Field names are selected.

Now you can save and close the form.

See also
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Run Custom Compiled Code

With the release of Impact 4.2 ﴾build 117﴿ you can now run compiled custom code from the data‐entry form
button control. This code can be written in VisualBasic or VisualCSharp.  You will need to build a DLL using
Visual Studio 2008 or better.

Create the DLL
In the VS project create a new class as shown below and compile into a DLL.

Public Class SDKExample

     Public Shared Function RunCustomCode(ByVal form As
Durkin.Common.Classes.frmSubEntityItemEditDurkin) As Boolean

        System.Diagnostics.Debugger.Break()

        Return True

    End Function

End Class

Installing the DLL
To install your custom dll please follow these steps:

1. Close ACT!
2. Copy your DLL into the plugin folder
3. Restart ACT

The ACT plugin folder is either at one of these two locations:
C:\Program Files ﴾x86﴿\ACT\Act for Windows\Plugins    ﴾ 64 bit machine﴿
C:\Program Files\ACT\Act for Windows\Plugins ﴾32 bit machines﴿

Calling the DLL code:
To call you custom code you need to add a button onto your form and set the buttons properties to match your;
DLL Name, Class and method. Please follow these steps:

1. Open you form in the designer
2. Change the drop down at the top of the toolbox to "Controls ‐ Specialized"
3. Drag the BUTTON [DLL INVOKE] onto your form

On the 'Custom Properties' panel change these properties
4. Set the dllclass property to Durkin.Custom.RunCustomCode.SDKExample
5. Set the dllfilename property to Durkin.Custom.RunCustomCode.dll
6. Set the dllmethod property to RunCustomCode
7. Save and close the form.
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Controls on Forms

There are many standard and customized controls that can be used on custom table forms. 
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Exisiting Fields

By selecting this drop down the toolbar just below the drop down will display a list of all existing fields in the
current custom table which have not been placed onto the data‐entry form.

See also
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Home > Impact Suite > Tables and Forms > Controls on Forms > Create Field

Create Field

By selecting this drop down the toolbar just below the drop down will display a list of field types you can place
on your data‐entry form. 

Add one of these fields will add the field into the custom table you are designing.

See also

Exisiting Fields
Parent‐Child Lists
Panels and Container
Specialzied Controls
Buttons and Picklists
Cascading Dropdowns
Contact, Company, Group and Opps fields

0 Tweet

Properties

Article ID: field_‐_new
Views: 185
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/24/2014 1:40 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article
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Parent‐Child Lists

Selecting the Lists button in the Forms Designer toolbar will display a list of tables you can place on your data‐
entry form. 

When one of these items are are places onto the form they list will be a child table or one of the top four tables
in ACT; contact, company, groups and opportunities.
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Home > Impact Suite > Tables and Forms > Controls on Forms > Panels and Container

Panels and Container

Selecting the Panels button in the toolbar will display a list of container style controls you can place on your
data‐entry form. 
 
Container controls are controls which hold multiple controls such as a panel or a tab control.
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Home > Impact Suite > Tables and Forms > Controls on Forms > Panels and Container > Group Box

Group Box

The GroupBox displays a frame around a group of controls with or without a caption. Use a GroupBox to logically group a
collection of controls on a form. The group box is a container control that can be used to define groups of controls.

The typical use for a group box is to contain a logical group of RadioButton controls. If you have two group boxes, each of which
contain several option buttons ﴾also known as radio buttons﴿, each group of buttons is mutually exclusive, setting one option value
per group.

In 5.1 two new properties were added ShowClearButton and ShowMiniClearButton

By default they are set to false

If ShowClearButton is set to true the groupbox will look like below the button will clear all the controls in the groupbox

If ShowMiniClearButton is set to true the groupbox will look like below the button will clear all the controls in the groupbox

See also
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Home > Impact Suite > Tables and Forms > Controls on Forms > Panels and Container > Panel

Panel

A Panel is a control that contains other controls. You can use a Panel to group collections of controls such as a group of
RadioButton controls. As with other container controls such as the GroupBox control, if the Panel control's enabled property is set
to false, the controls contained within the Panel will also be disabled.

The Panel control is displayed by default without any borders. You can provide a standard or three‐dimensional border using the
border style property to distinguish the area of the panel from other areas on the form. Because the Panel control derives from the
scrollable class, you can use the autoscroll property to enable scroll bars in the Panel control. When the autoscroll property is set to
true, any controls located within the Panel ﴾but outside of its visible region﴿, can be scrolled to with the scroll bars provided.

The Panel control does not display a caption. If you need a control similar to a Panel that can display a caption, see the
GroupBox control.

See also
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Panel with Total Footer

Home > Impact Suite > Tables and Forms > Controls on Forms > Panels and Container > Panel with Total Footer

Panel with Total Footer
This control will add up the number, decimal or currency fields you add into the panel and display the total amount in the footer.  

To add this control onto a form follow these steps in the designer:

1. Click on the Panels and Container icon on the top toolbar
2. Select the Panel with Total Footer
3. Drag it onto your form

Once you have the panel on the form you can drag field into the panel by following these steps:

1. Click on the Existing Fields  icon on the top toolbar
2. Select any numeric field from the  list
3. Drag it into your panel
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You can set the properties of the panel using the Properties area in the lower left corner. The properties include:

Border: The border around the panels
Show Clear Button: Is the CLEAR button visible. This button clears all the values for each field in the panel

Text : Not used at this time

Tooltip: The tooltip to display when the mouse hover over the panel.

Total Alignment: The alignment of the total value at the bottom of the panel

Total Format String: the formatting of the total value. c for currency, n for numeric

Total Target: This is the targeted total for the sum of all fields. When this total is under the target the total value will be RED. When
this target value is met or exceeded the total value will be BLANK

See also
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Tab Control

You can use tabs to help organize like information together. On the screen shot below we are grouping all the "Camera Settings"
together under the second tab. To add multiple tabs onto your layout follow these steps:

1. Open a form in the DESIGNER
2. Click on the CUSTOM CONTROLS tab at the top left side of the window
3. DRAG the item "TabControlDurkin" onto the form.
4. Click the "ADD TAB" link at the bottom of the properties list for as many tabs as you desire.

To change Tabs settings like the label, follow these steps:

1. In the properties list select TABPAGES
2. Click the ellipses buton [...]
3. Click on the ADD button at the top of the window
4. In this list you can select TEXT to change the tabs label

And yes, you can have tabs inside of tabs. Unlimited child tabs are supported

See also
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Home > Impact Suite > Tables and Forms > Controls on Forms > Specialzied Controls

Specialzied Controls

By selecting this drop down the toolbar just below the drop down will display a list of generic  control  you can place on your
data‐entry form. 

Generic controls are defined as controls which have not been attached to a specific field in the custom table. Once you drag one of
these generic fields you will be presented with a dial to select the field from the custom table.

You can use these controls to place two controls attached to the same field. This may be handle if you want to see a field under two
different tab or in two sections of the data‐entry form.  These two controls will sync with each otehr so when the value of one
control changes the value of the second control is updated.
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Auto Increment

This is a specialized control in the designer for auto‐incrementing a field. This control is based on a text box and
will automatically increment by one its value based on the highest previous value in the ACT! database. Any
time you create a new item the value will auto‐increment. If you open an existing item that was previously left
blank then the value will auto‐increment.
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Follow these steps to add the auto‐increment control onto the form.

1. Open the form in the Designer
2. Click on the Specialized Controls button in the toolbar.
3. Drag the item labeled Auto Increment onto the form
4. A Select field window will come forward choose the table name 
5. Select the field to increment
6. Click on the OK button to save changes

 

  

Last Modified: 7/15/2014 12:58 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/auto_increment


See also

Calendar Combo
Calendar Month
Check Box
Checked List Box
Combo Box
Drop Down
File Picker
Folder Picker
Label
LabelData
Numeric Edit Box
Numeric UpDown
Picture
Memo
Text Box
Text Box ‐ Currency
Text Box ‐ Incremental
Text Box ‐ Numeric
Text Box ‐ Hot Linked
Text Box ‐ MultiLine

 

Home > Impact Suite > Tables and Forms > Controls on Forms > Specialzied Controls > Calendar Combo

Calendar Combo
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The calendar combo control allows you to select a date and save it to an associated Act field.

Follow these steps to add the calendar combo control onto the form.

1. Open the form in the Designer
2. Click on the controls ‐ generic drop down at the top left.
3. Drag the item labeled calendar combo onto the form
4. From the PROPERTIES window go to the ACTFIELD item.
5. Using the DropDown list select your desired ACT field.
6. Click on the SAVE button to save changes.

After you have the date control on the form you can set some of the default options such as:

Default Business Days
Count only business days when adding days tot he default date. ﴾business days are always Mon‐Fri﴿
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Default Days to Add
Default the field to todays date plus x days

Default Months to Add
Default the field to todays date plus x month

Great options for when you are creating a service style ticket which needs to be followed up in the future

Default to Today
Default the field to today's date

Show Age
Show the age of the date field

Show Only Time
Hides the date and only show the time portion

Show Time
Show the time portion of the date time

Tooltip
Enter a tooltip to be displayed when the user hovers the moue over the control
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Calendar Month

The calendar combo control allows you to select a date from a month format control and save it to an
associated Act field.

Follow these steps to add the calendar combo control onto the form.

1. Open the form in the Designer
2. Click on the controls ‐ generic drop down at the top right.
3. Drag the item labeled Calendar Month onto the form
4. From the PROPERTIES window go to the ACTFIELD item.
5. Using the DropDown list select your desired ACT field.
6. Click on the SAVE button to save changes.
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Check Box

Use a CheckBox to give the user an option, yes/no.  

CheckBox and RadioButton controls have a similar function: they allow the user to choose from a list of options.
CheckBox controls let the user pick a combination of options. In contrast, RadioButton controls allow a user to
choose from mutually exclusive options.

The appearance property determines whether the CheckBox appears as a typical CheckBox or as a button.

The threestate property determines whether the control supports two or three states. Use the checked  property
to get or set the value of a two‐state CheckBox control and use the checkstate property to get or set the value of
a three‐state CheckBox control.
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Checked List Box

The Checked ListBox control enables you to display a list of items to the user that the user can select by checking the box. A
Checked ListBox control can provide one or multiple selections using the SelectionMode property. The Checked ListBox also
provides the MultiColumn property to enable the display of items in columns instead of a straight vertical list of items. With this, the
control can display more visible items and the user no longer needs to scroll to an item.
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Combo Box

A ComboBox displays a text box combined with a ListBox, which enables the user to select items from the list or
enter a new value. The combo box is used for a field associated with an ACT drop down list

Set the field to an ACT field with a drop down list.
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Drop Down

This control is no longer a separate control, it's properties have been incorporated into the generic Drop Down
control.  
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The drop down lookup control ﴾ also known as a PickList control ﴿ will create a drop down of distinct values
from a custom tables field.  Choosing a value form the drop down will copy selected fields from the custom
table to the current record.

This control will replace the field value with the value from the drop down list. If you want to replace multiple
fields at the same time please see the Pick List from [Custom Table] control. 

To set up the control set the ACTLookupTable to the custom table to be looked up and the ACTLookupField to
the Act field from the custom table.  

Click the ellipses from ACTLinkedFields and choose the fields to copy from the custom table into the current
record.
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File Picker

The File Picker Control lets you pick a file and store it's path into an ACT Character Field.  Clicking the elipses﴾...﴿
button in the control will bring forward a open file dialog to choose the file.

ACTAskToLink
When set to true a window will ask if the file should be linked.  If the answer is yes the file will also be attached
to the parent contact, company, group or opportunity as a LNK file.
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Folder Picker

The File Picker Control lets you pick a folder and store it's path into an ACT Character Field. Clicking the
elipses﴾...﴿ button in the control will bring forward a folder browser dialog to choose the folder.
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Label

Label controls are typically used to provide descriptive text for a control. For example, you can use a Label to
add descriptive text for a TextBox control to inform the user about the type of data expected in the control. Label
controls can also be used to add descriptive text to a Form to provide the user with helpful information. For
example, you can add a Label to the top of a Form that provides instructions to the user on how to input data in
the controls on the form. Label controls can be also used to display run time information on the status of an
application. For example, you can add a Label control to a form to display the status of each file as a list of files
is processed.

A Label participates in the tab order of a form, but does not receive focus ﴾the next control in the tab order
receives focus﴿. For example, if the UseMnemonic property is set to true, and a mnemonic character—the first
character after an ampersand ﴾&﴿—is specified in the Text property of the control, when a user presses ALT+
the mnemonic key, focus moves to the next control in the tab order. This feature provides keyboard navigation
for a form. In addition to displaying text, the Label control can also display an image using the Image property,
or a combination of the ImageIndex and ImageList properties.
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LabelData

LabelData controls are typically used to display field information but not allow the user to change that
information. For example, the LabelData could show the results of a math calculation that should not be
changed or information form the contact that the record is attached to.

The format of the label can be set from the FormatString property
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Numeric Edit Box

The Numeric Edit Box control is build off of the standard Microsoft .Net control. The properties for the standard
control can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx. It is
customized to have a ValueType of Decimal, this control is ideal for using with numbers, decimals and currency.

The added properties for the control are ACTField, ACTSecurity and EntityName. 

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams. To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Numeric UpDown

This opening paragraph should describe the feature that you are documenting. Explain how it is commonly
used and what the benefits are. For example: The Widget Master email link allows you to easily send
information about each widget to various departments within your company. Often, the feature that you are
documenting can be best explained by walking the reader through step by step. Use screenshots to illustrate
the steps where possible.

1. Start the application by…
2. On the startup screen, click the…
3. 

See also

Auto Increment
Calendar Combo
Calendar Month
Check Box
Checked List Box
Combo Box
Drop Down
File Picker
Folder Picker
Label
LabelData
Numeric Edit Box
Picture
Memo
Text Box
Text Box ‐ Currency
Text Box ‐ Incremental
Text Box ‐ Numeric
Text Box ‐ Hot Linked
Text Box ‐ MultiLine

0 Tweet

Properties

Article ID: numeric_updown
Views: 196
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/24/2014 1:43 PM

Actions

Print This Article
Bookmark
Email This Article

Previous Article

Next Article

 

https://twitter.com/share
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/numeric_updown


Home > Impact Suite > Tables and Forms > Controls on Forms > Specialzied Controls > Picture

Picture

This opening paragraph should describe the feature that you are documenting. Explain how it is commonly
used and what the benefits are. For example: The Widget Master email link allows you to easily send
information about each widget to various departments within your company. Often, the feature that you are
documenting can be best explained by walking the reader through step by step. Use screenshots to illustrate
the steps where possible.

1. Start the application by…
2. On the startup screen, click the…
3. 
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Memo

This opening paragraph should describe the feature that you are documenting. Explain how it is commonly
used and what the benefits are. For example: The Widget Master email link allows you to easily send
information about each widget to various departments within your company. Often, the feature that you are
documenting can be best explained by walking the reader through step by step. Use screenshots to illustrate
the steps where possible.

1. Start the application by…
2. On the startup screen, click the…
3. 
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Text Box

The text box control is build off of the standard Microsoft .Net control.  The properties for the standard control
can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx.  

The added properties for the control are ACTField, ACTSecurity and EntityName.  

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams.  To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Text Box ‐ Currency

The text box control is build off of the standard Microsoft .Net control. The properties for the standard control
can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx. It is
customized to have a ValueType of Decimal, this control is ideal for using with currency fields.

The added properties for the control are ACTField, ACTSecurity and EntityName. 

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams. To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Text Box ‐ Incremental

The text box control is build off of the standard Microsoft .Net control. The properties for the standard control
can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx. 

The added properties for the control are ACTField, ACTSecurity and EntityName. 

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams. To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Text Box ‐ Numeric

The text box control is build off of the standard Microsoft .Net control. The properties for the standard control
can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx. It is
customized to have a ValueType of Decimal, this control is ideal for using with number fields.

The added properties for the control are ACTField, ACTSecurity and EntityName. 

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams. To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Text Box ‐ Hot Linked

The text box control is build off of the standard Microsoft .Net control. The properties for the standard control
can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx. 

The added properties for the control are ACTField, ACTSecurity and EntityName. 

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams. To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Text Box ‐ MultiLine

The text box control is build off of the standard Microsoft .Net control. The properties for the standard control
can be found here http://msdn.microsoft.com/en‐us/library/system.windows.controls.textbox.aspx. 

The added properties for the control are ACTField, ACTSecurity and EntityName. 

ACTField is the field that the control will save to
ACTSecurity is the field where the control can be made non editable based on users or teams. To learn more
about adding security to controls go here Add Field Security .
EntityName is the name of the table that the ACTField is coming form
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Buttons and Picklists

By selecting this drop down the toolbar just below the drop down will display a list of specialized controls  you can place on your
data‐entry form. 
 

Specialized controls including:

Multi‐purpose buttons which run code snippets.
Field and folder pickers
Pick list from other custom table sources
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Home > Impact Suite > Tables and Forms > Controls on Forms > Buttons and Picklists > Button [Attach File]

Button [Attach File]

The button attach file control adds a button with that will add a file to the history of the attached contact.  When clicked on a form
the button will open a window to select the file to attach and then attach that file.

The default code in the control is 

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' Attach a file
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
 HostApplication.UIHistoryManager.AttachFile﴾﴿

To change the default code, click the ellipses ﴾...﴿ button in the properties panel, change the code and click save. 
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Home > Impact Suite > Tables and Forms > Controls on Forms > Buttons and Picklists > Button [Create Activity]

Button [Create Activity]

The button create activity control will bring forward the the schedule activity window from ACT.

The default code is 

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
' Attach a file
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
 Dim aActivityType As ACT.Framework.Activities.ActivityType = HostFramework.Activities.GetActivityType﴾0﴿
HostApplication.UIActivityManager.ScheduleNewActivity﴾aActivityType﴿

To change the default code, click the ellipses ﴾...﴿ button in the properties panel, change the code and click save. 
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Home > Impact Suite > Tables and Forms > Controls on Forms > Buttons and Picklists > Button [Create History]

Button [Create History]

The create history button control will create a history for the contact when pressed

The default for the button is 

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
' Create a new history
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
HostApplication.UIHistoryManager.RecordHistory﴾﴿

To change the default code, click the ellipses ﴾...﴿ button in the properties panel, change the code and click save. 
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Home > Impact Suite > Tables and Forms > Controls on Forms > Buttons and Picklists > Button [Create Note]

Button [Create Note]

The create note button control will bring forward note creation window for the contact when pressed

The default for the button is 

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
' Create a new note
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
HostApplication.UINoteManager.InsertNote﴾﴿

To change the default code, click the ellipses ﴾...﴿ button in the properties panel, change the code and click save. 
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Home > Impact Suite > Tables and Forms > Controls on Forms > Buttons and Picklists > Button [OK]

Button [OK]

The button ok control will place a button on the form that will save and close the form when pressed
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Button [Cancel]

The button cancel control will place a button on the form that will cancel and close the form when pressed
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Button [DLL Invoke]

The button dynamic dll control will when clicked call an outside dll to be run
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Home > Impact Suite > Tables and Forms > Controls on Forms > Buttons and Picklists > Button [MapIt­DriveIt]

Button [MapIt‐DriveIt]

The button map it drive it control will bring forward a screen when clicked to get directions between two locations.  Directions for
map it drive it can be found here.

To change the default code, click the ellipses ﴾...﴿ button in the properties panel, change the code and click save. 

The default code for the button is 

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' Get the form the user is working on
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
Dim EntityForm as Durkin.Common.Classes.frmSubEntityItemEditDurkin
EntityForm  = directCast﴾SubEntityForm, Durkin.Common.Classes.frmSubEntityItemEditDurkin﴿

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' Get the STARTING point contact
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' My record
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
'Dim StartContact as Act.Framework.Contacts.Contact = HostApplication.ActFramework.Contacts.GetMyRecord﴾﴿

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' First contact atached to the record
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
Dim StartContact as Act.Framework.Contacts.Contact = EntityForm.GetEntityItem﴾﴿.GetContacts﴾nothing﴿﴾0﴿

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
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' Get the FROM addresses from the STARTING CONTACT
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
Dim fAddress As String = Contacts.GetContactFieldDescriptorByANY﴾HostFramework, "Address 1"﴿.GetValue﴾StartContact ﴿
Dim fCity As String = Contacts.GetContactFieldDescriptorByANY﴾HostFramework,
"TBL_CONTACT.BUSINESS_CITY"﴿.GetValue﴾StartContact ﴿
Dim fState As String = Contacts.GetContactFieldDescriptorByANY﴾HostFramework,
"TBL_CONTACT.BUSINESS_STATE"﴿.GetValue﴾StartContact ﴿
Dim fPostal As String =Contacts.GetContactFieldDescriptorByANY﴾HostFramework,
"TBL_CONTACT.BUSINESS_POSTALCODE"﴿.GetValue﴾StartContact ﴿
Dim fCountry As String = Contacts.GetContactFieldDescriptorByANY﴾HostFramework,
"TBL_CONTACT.BUSINESS_COUNTRYNAME"﴿.GetValue﴾StartContact ﴿

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' Get the DESTINATION addresses from the current record
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
Dim dAddress As String = CustomSubEntity.GetFieldDescriptorByANY﴾"Destination Address",
EntityForm.GetEntityManager﴾﴿﴿.GetValue﴾EntityForm.GetEntityItem﴾﴿﴿
Dim dCity As String = CustomSubEntity.GetFieldDescriptorByANY﴾"Destination City",
EntityForm.GetEntityManager﴾﴿﴿.GetValue﴾EntityForm.GetEntityItem﴾﴿﴿
Dim dState As String = CustomSubEntity.GetFieldDescriptorByANY﴾"Destination State",
EntityForm.GetEntityManager﴾﴿﴿.GetValue﴾EntityForm.GetEntityItem﴾﴿﴿
Dim dPostal As String = CustomSubEntity.GetFieldDescriptorByANY﴾"Destination Postal",
EntityForm.GetEntityManager﴾﴿﴿.GetValue﴾EntityForm.GetEntityItem﴾﴿﴿
Dim dCountry As String = CustomSubEntity.GetFieldDescriptorByANY﴾"Destination Country",
EntityForm.GetEntityManager﴾﴿﴿.GetValue﴾EntityForm.GetEntityItem﴾﴿﴿

'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 
' Send the information to Google Maps
'‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐
Dim MapIt As New Durkin.Common.Views.frmMapit﴾fAddress , fCity , fState , fPostal , fCountry , dAddress , dCity , dState , dPostal ,
dCountry ﴿
MapIt.Show﴾﴿
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Picklist From Contacts

The picklist from contacts control will bring forward a window to select select a contact and copy chosen fields from the contact
table to the current custom table.

To setup the control you need to set the fields that are copied in the properties 
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Picklist From Companies

The picklist from companies control will bring forward a window to select select a company and copy chosen fields from the
company table to the current custom table.

To setup the control you need to set the fields that are copied in the properties 
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Picklist From Groups

The picklist from groups control will bring forward a window to select select a group and copy chosen fields from the group table
to the current custom table.

To setup the control you need to set the fields that are copied in the properties 

See also
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Picklist From Opportunities

The picklist from opportunities control will bring forward a window to select select an opportunity and copy chosen fields from the
opportunity table to the current custom table.

To setup the control you need to set the fields that are copied in the properties 
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Picklist From [Custom Table]

The pick list from [custom table] ﴾ aka cascade drop down﴿ control will bring forward a window to select select an record from a
custom table and copy multiple values into multiple fields from the that table to the current custom table.

This control is much like a cascading pick list where each subsequent field filters down the next field. For instance; you need
three drop downs such as make, model and version. First you need to create a custom table to store the values. These values will
be stored in fields named make model and version. Using the interface of the 'Automobiles' table you can either import or data‐
enter your values such as VW, Fords, Chevy and so forth.
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To import records into the master list, the best way would be to use the single import.  You can find more information here.

This control will replace multiple field values with the value from the drop down list. If you want to replace just a single fields  please
see the Drop Down Lookup

To use this control follow these steps.
1﴿ Open the form in the forms designer

2﴿ Click the "Buttons" button in the toolbar

3﴿ Drag the "Picklits from xxxxx" controls onto the form. ﴾Where xxxxx is the custom table to want to use as the pick list data
source﴿

 

 4﴿ This Edit Linked Fields form will automatically pop open. You need to use the drop downs to match the fields from the pick list
table ﴾ source﴿ into your fields in the custom table you are currently editing ﴾ destination﴿

To setup the control you need to set the fields that are copied in the properties 

You can set the text on the button by changing the Button text Property

The next time you use the form you now have a Pick List button. If you click on this button it will open a window listing all the
available entries in the source table.

1﴿ Enter lookup criteria using the the ﴾1﴿ global find which filters all the visible columns.

2﴿ Enter filter criteria at the top of each column

Click OK when you have completed your look‐up.
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The selected record form the Automobile table is used to populate all the fields in your custom table.

cascade dropdown, cascading drop down, cascading dropdown
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Cascading Dropdowns

Cascading drop downs let you pick fields to narrow down entries from another table and insert those fields into
the current table.  This works well for picking make and model for cars or an item that is sold by a company.

1. In the designer click on the Cascading Dropdowns button in the toolbar
2. Drag over the control 'Cascade from [table name]' that is the table you want to select from
3. A window will allow you to select the fields from the source table and pick what fields to put them in on the current table
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If you need to re‐open the cascade editor please click on the "..." ellipse button next the the CascadingField
property in the lower left side

The cascade editor allows you to select the fields to add onto the cascading control. The list on the left side is
the frilds from the source table. The fields on the fight are the destination fields in the current custom table. To
add fields follow these steps:

1. Select a field from the source table 
2. Click on the ADD‐> button
3. From the popup form select the destination field and click OK

In the list above the "Body Color" field form the source will be copied <into> the "Color" field in the current custom table.
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Contact, Company, Group and Opps fields

When you add a custom table you may need to attach multiple contacts, companies, groups and/or
opportunities. Using any one or a combination of these four controls you can attach the custom record to each.

To add one of these controls open the form in the designer and ollow these steps:

1. Click on the "Parent‐Child icon on the top toolbar

2. From the TOOLBOX list on the left side select your desired entity

3. Drag the control onto the form
4. Use the PROPERTIES panel set your desired options.
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Attach Contacts

This control allows you to select which CONTACT the record in the custom table is attached to. You can use this control to add
fields from the contact table onto the data entry form such as city, state or zip. This control by default displays the contact name but
can be set to any other field. You can add multiple controls to display multiple fields at the same time such as the address on the
attached contact.

To add one of these controls open the form in the designer and follow these steps:

1. Click on the "Parent‐Child icon on the top toolbar
2. From the TOOLBOX list on the left side select your desired entity
3. Drag the control onto the form
4. Use the PROPERTIES panel set your desired options
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In the picture below we added four additional field using the same steps as above. Each time we added the control we changes the
property to display different fields from the contact table.

1. Using the mouse select the control.
2. On the left side use the properties panel to change your desired options

There are two buttons on the right side of the control. These button action are:
Hyperlink Button ‐ Forces act! to display the attached contact on the contact details view behind the data entry form.

Lookup Button ‐ Opens the Entity Picker to select the contacts to attach to the current record.

In the properties panel these options are available:

ACT Field:  The field to display in the control

ACT Table Display: The display order if there are multiple contact attached.

ACT Table Order:The order of the field being displayed if multiple contacts are attached.

Open Picker Company Contact: Option to open the entity picker for the companies attached to the current contact
       ﴾ Only available when using the Company Control﴿

Open Picker Empty:  When the Lookup Button is clicked which opens the contact picker  this options set if the attached contacts are
pre‐selected. When TRUE no contacts are pre‐selected.

Show Button: Is the Lookup Button visible ﴾ For fields such as address you may ant this option FALSE﴿

Show Contact and Company: Does the text box display the contact name and the company name. "Chris Huffman [CH TechONE]"
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Show Nav Button: Is the Hyperlink button visible ﴾ For fields such as address you may ant this option FALSE﴿

Tooltip: Display a tool tip wen the mouse hovers over the control. This can be useful for training and verification of data entry
requirements.

See also

Attach Companies
Attach Groups
Attach Opportunities
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Attach Companies

This control allows you to select which COMPANIES the record in the custom table is attached to. You can use this control to add
fields from the company table onto the data entry form such as city, state or zip. This control by default displays the company name
but can be set to any other field. You can add multiple controls to display multiple fields at the same time such as the address on
the attached companies.

To add one of these controls open the form in the designer and follow these steps:

1. Click on the "Parent‐Child icon on the top toolbar
2. From the TOOLBOX list on the left side select your desired entity
3. Drag the control onto the form
4. Use the PROPERTIES panel set your desired options

  

There are two buttons on the right side of the control. These button action are:
Hyperlink Button ‐ Forces act! to display the attached contact on the contact details view behind the data entry form.

Lookup Button ‐ Opens the Entity Picker to select the contacts to attach to the current record.

In the properties panel these options are available:

ACT Field:  The field to display in the control
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ACT Table Display: The display order if there are multiple companies attached.

ACT Table Order:The order of the field being displayed if multiple companies are attached.

Open Picker Company Contact: ONLY USED IN CONTACT 

Open Picker Empty:  When the Lookup Button is clicked which opens the contact picker  this options set if the attached companies
 are pre‐selected. When TRUE no companies are pre‐selected.

Show Button: Is the Lookup Button visible ﴾ For fields such as address you may ant this option FALSE﴿

Show Contact and Company: ONLY USED IN CONTACT

Show Nav Button: Is the Hyperlink button visible ﴾ For fields such as address you may ant this option FALSE﴿

Tooltip: Display a tool tip when the mouse hovers over the control. This can be useful for training and verification of data entry
requirements.

See also
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Attach Groups

This control allows you to select which GROUPS the record in the custom table is attached to. You can use this control to add fields
from the group table onto the data entry form such as description. This control by default displays the group name but can be set
to any other field. You can add multiple controls to display multiple fields at the same time.

To add one of these controls open the form in the designer and follow these steps:

1. Click on the "Parent‐Child icon on the top toolbar
2. From the TOOLBOX list on the left side select your desired entity
3. Drag the control onto the form
4. Use the PROPERTIES panel set your desired options
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There are two buttons on the right side of the control. These button action are:

Hyperlink Button ‐ Forces act! to display the attached groups on the group details view behind the data entry form.

Lookup Button ‐ Opens the Entity Picker to select the groups to attach to the current record.

In the properties panel these options are available:

ACT Field:  The field to display in the control

ACT Table Display: The display order if there are multiple groups attached.

ACT Table Order:The order of the field being displayed if multiple groups are attached.

Open Picker Company Contact: ONLY USED IN CONTACT 

Open Picker Empty:  When the Lookup Button is clicked which opens the group picker this options sets if the attached groups are
pre‐selected. When TRUE no groups are pre‐selected.

Show Button: Is the Lookup Button visible ﴾ For fields such as description you may ant this option FALSE﴿

Show Contact and Company: ONLY USED IN CONTACT

Show Nav Button: Is the Hyperlink button visible ﴾ For fields such as description you may ant this option FALSE﴿

Tooltip: Display a tool tip when the mouse hovers over the control. This can be useful for training and verification of data entry
requirements.
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Attach Opportunities

This control allows you to select which OPPORTUNITIES the record in the custom table is attached to. You can use this control to
add fields from the opportunity table onto the data entry form such as status and/or open date. This control by default displays the
opportunity name but can be set to any other field. You can add multiple controls to display multiple fields at the same time.

To add one of these controls open the form in the designer and follow these steps:

1. Click on the "Parent‐Child icon on the top toolbar
2. From the TOOLBOX list on the left side select your desired entity
3. Drag the control onto the form
4. Use the PROPERTIES panel set your desired options
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There are two buttons on the right side of the control. These button action are:

Hyperlink Button ‐ Forces act! to display the attached opportunities on the opportunities details view behind the data entry form.

Lookup Button ‐ Opens the Entity Picker to select the opportunity to attach to the current record.

In the properties panel these options are available:

ACT Field:  The field to display in the control

ACT Table Display: The display order if there are multiple opportunities attached.

ACT Table Order:The order of the field being displayed if multiple opportunities are attached.

Open Picker Company Contact: ONLY USED IN CONTACT 

Open Picker Empty:  When the Lookup Button is clicked which opens the opportunity picker this options sets if the attached
opportunity  are pre‐selected. When TRUE no groups are pre‐selected.

Show Button: Is the Lookup Button visible ﴾ For fields such as status and/or open date you may ant this option FALSE﴿

Show Contact and Company: ONLY USED IN CONTACT

Show Nav Button: Is the Hyperlink button visible ﴾ For fields such as status and/or open date you may ant this option FALSE﴿

Tooltip: Display a tool tip when the mouse hovers over the control. This can be useful for training and verification of data entry
requirements.

See also
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Field Designer

When creating a custom table you will probably start with one of the table templates. But there will be times when the template just
does not have enough fields for your workflow. To overcome this just add new fields into the custom table. You can add almost any
style of field ‐ from character to numeric to picture fields. To add a new field to a custom table, follow these steps:

1. In ACT go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Select the table to alter
3. On the upper left click on the CREATE FIELD
4. Give the field a name and select the data type such as PICTURE
5. Click NEXT and fill out your desired settings
6. Click FINISHED when completed and the field will be added to the custom table

To Edit a field

1. In ACT go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Select the field to alter
3. On the upper left click on the EDIT FIELD
4. Change the desired settings
5. Click NEXT and change any other settings
6. Click FINISHED when completed and the field will be updated in the custom table

To remove a field from a custom table, follow these steps:

1. In ACT go to the TOOLS menu and select DEFINE CUSTOM TABLES
2. Select the table to alter
3. Click on DELETE FIELD
4. Answer yes to delete the field
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Table Designer

The best place to start adding your first custom table is by using one of the pre‐defined templates. These templates contain some
basic fields. You can add additional fields or alter the existing field from the template after it is added to the database. For the
purpose of this manual we will create our table directly from a template:

1. Go to the TOOLS menu and select DEFINE CUSTOM TABLES 
2. Click on the CREATE TABLE BUTTON
3. Give your new table a name.
4. Click on the SAVE button, a progress bar will display the process of adding the table and the fields.
5. When completed you will be notified with a small dialog box. Click OK to close.
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Templates aren't the only way to create a table
You can easily create a table from a template but you can also create a new ﴾Blank﴿ table and add all your own fields. Here are
some ways to add new custom tables.
1﴿ Using one of our pre‐defined templates
2﴿ From an existing ACT! table like Contacts or Activities
3﴿ From a template supplied to you from a consultant
4﴿ Empty table where you add all your own fields "﴾Blank﴿"

Templates provide a great starting point for your table designs 
We have pre‐defined many templates for many different industries but you are the ultimate decision maker of what data you need
to capture. We suggest starting out with a template to get the basics in place ‐ but adding additional fields required by you and or
your company. If you are working with a consultant they can also provide you with a custom template. Remember, you can always
go back and add more fields at any time in the future.
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Tab Order on Detail View
The custom table tab order can be ordered to put the custom tables in a specific order.

Go to Tools > Design layouts > Choose the Act entity layout to order.

In the layout designer press F4 to show the properties window ﴾1﴿ > select the tab control ﴾2﴿ > click the
eclipses in the Edit Tabs property

 
Click the Add Tab button ﴾1﴿ add the name of the custom table and position the tab using the Move Up and
Move Down buttons ﴾2﴿.  When the layout is loaded Impact will put the custom table where you placed it with
the Edit Tabs window.
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Import Files
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Import to Custom Table

Once you have a custom table you can populate the records from an external file.  To import from a file into a
custom table follow the steps below.

1  Open ACT

2  Click File > Import into custom tables

3  Click the next button

0 Tweet

Properties

Article ID: import_to_custom_table
Views: 169
Created By: jimdurkin
Modified By: [Modified By]
Created Date: 3/24/2014 12:31 PM
Last Modified: 3/27/2014 11:34 AM

Actions

#_Anchor_math1
#_Anchor_memo_w_spell_checking
#_Anchor_printing1
#_Anchor_how-to_examples1
https://twitter.com/share
#_Anchor_mailto_xx_%20?subject=helpconsole%20knowledgebase%20article&body=durkincomputing.com/helpconsole2014/impact/import_files
https://twitter.com/share


4  Click the browse button to choose a file to import.  Valid file types are Excel ﴾ .xls & .xlsx ﴿, Comma Delimited ﴾
.csv ﴿ & XML.  If you choose an Excel file select the sheet name for the file

5  Select the ACT table name that the records will be attached to and the table name of the custom table.  The
two drop down lists give the choice to do not change or replace with source, do not change will not change any
fields if on importing replace with source will overwrite the data in the ACT database with the information from
the external file.  If the "Attach multiple Act entities" checkbox is checked and a primary key for the custom table
is set in step 6, when importing if the custom table record is found more than once during the import each Act
entity will be attached to the custom table record.

6  Math the external file fields with the correct table name and table field from ACT.  At lease one key is required
for the ACT table, this is used to find the correct ACT entities to attach the records to.  A key is not required for
the custom table, it is only needed if you want to update records already in the database.
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7  When the import is done a window will say "Import Complete"

 

See also

Import to Custom Records to Single ACT entity
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Import to Custom Records to Single ACT entity

Records can be directly imported to a Contact, Company, Group or Opportunity.

1  On the detail view click on the table names tab 

2  Click on the import button in the toolbar

3  A dialog will come forward asking if you want to continue importing

4  Select the file to import

5  A simplified version of the custom table importer will come forward.  Choose the sheet and if data should be
left unchanged or replaced.  Map the fields from the external file to the custom table fields.  If you choose to
replace with source you need to select a key match on.

6  When finished a box will say "Import complete"
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